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Preface

Book expectations


https://www.joomlapolis.com/community-builder

Who is this book for?

Anyone who wants to get up to speed quickly with Community Builder (abbreviated CB throughout
this document) will find this book valuable.

What’s in this book?

This book introduces some of the main features of Community Builder, the social networking
platform for Joomla.

The layout of this book is somewhat unconventional as it follows a quick-start approach showing
you things you can do out-of-the-box with little or no extra configuration and then gradually
introduces extra configuration possibilities as they are needed. Sometimes the images included to
help explain one topic also introduce elements and features that will make the reader think and
understand future possibilities. This approach hopefully makes reading more enjoyable and easier
to follow.

The concepts explored are:

* Expectations, installation and first steps ( Chapter 1 and Chapter 2)

* Working with fields and a closer look at image fields ( Chapter 3 and Chapter 4)
* Creating user lists and searching for users ( Chapter 5)

* Working with tabs, display types and profile positions ( Chapter 6 )

* Exploring operations with user management ( Chapter 7))

* Plugin concepts and built-in apps ( Chapter 8)

* Configuring and exploring user connections ( Chapter 9)

* Language translation concepts ( Chapter 10 )

* More configurations and implication tips ( Chapter 11)

* Conclusions and more resources ( Chapter 12 and Appendix A )

Where to get more help

This book, other Community Builder guides, the built-in Help system, and user support systems
assume that you are familiar with your computer and basic Joomla functions and operations.
Help system

Community Builder comes with an extensive Help system. This is your first line of support for using
Community Builder. The built-in Help system is comprised of Help pages and field tooltips.

To reach a Help page, click on the Help button on the upper right hand (left for RTL cases) corner
of any CB administrative page below the Joomla logo as shown in Figure 1.

CB20TUTORIALS & B ~

7 Joomlal

ﬁ @ Help
Figure 1: Help button
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To view a field tooltip, hover the mouse pointer over the small round information icon to see a
popup box (tooltip) with a brief explanation of the field's purpose. A sample popup tooltip is shown

in Figure 2.

Free online support

Publish
Yes €

Type

Image ?

Tab Type
Canvas  gystem fields type can not be

changed.
Required

Not Required % ©
Read Only

- 3

Figure 2: Tooltip popup

The Joomlapolis community not only helps develop software, but provides free, volunteer-based
support. See Table 1 and this web page: http://www.joomlapolis.com/support for relevant

resources.

Table 1: Free support for Community Builder users

Free Community Builder support

Questions and answers from the CB community on the Joomlapolis

Ask Community forums.

www.joomlapolis.com/forum/community-discussions
. The Community Builder 2.0 Primer.

Documentation .
This document.
Answers to frequently asked questions

FAQs . .
www.joomlapolis.com/support/faq

. A variety of online tutorials are available on Joomlapolis

Tutorials . . .

www.joomlapolis.com/support/tutorials
. The Joomlapolis Youtube channel has many video tutorials.
Videos

www.youtube.com/Joomlapolis

Getting Started articles

A number of Getting Started articles have been prepared to help you.
www.joomlapolis.com/documentation/community-builder/getting-started

Searching Paid
Forums

The paid support forums on Joomlapolis are great read-only references
that are freely available to everyone.
www.joomlapolis.com/forum/152-support-and-presales
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Paid support and training

Alternatively, you are able to pay for support services and add-ons that add new functionality to
Community Builder. Paid resources are shown in Table 2.

Table 2: Paid support and add-ons for Community Builder users

Paid Community Builder add-ons and support

Professional

You can purchase a Professional membership subscription to get more
add-ons and posting rights on the Joomlapolis Professional Support
forum where CB Team members provide same/next business day
responses for any issues you may encounter on any of your CB website

Membership installations. More information about Professional membership is
available here:
www.joomlapolis.com/support/membership
Purchasing a Developer membership subscription gives you access to all
Joomlapolis add-ons, CBSubs GPL, CB Package Builder and Joomla
Developer GPL Templates. You can also post on the Developer Support forums for
Membership same/next business day responses for all your customer CB website
installations.
www.joomlapolis.com/forum/255-developer-members-support
To add paid (or free) subscription membership levels to your website, you
CBSubs Paid can subscriber to the CBSubs GPL membership level (or Developer
Subscriptions level) and download CBSubs GPL for your CB website.
Membership More information about CBSubs can be found here:

www.joomlapolis.com/cb-solutions/cbsubs

CB Package Builder

Most powerful and flexible file download solution for Joomla. This CB
plugin lets you transform your digital files into packages that can only be
downloaded by authorized users. Joomla ACL is supported along with
built in conditions (based on user CB field values) can be used for
download authorization. CB Packager Bot, CBSubs Packager Bot and

Membership CB Packager module also available in this all inclusive package that is
also available to Developer Membership subscribers.
More information about CB Package Builder can be found here:
www.joomlapolis.com/addons/ch-package-builder
p All paid subscribers automatically get access to download the Footer
owered by

Community Builder
Footer Removal

removal plugin. You can also remove the footer under a very reasonable
sponsoring subscription as described here:
www.joomlapolis.com/community-builder-remove-footer

Joomlapolis Joomla
GPL Templates

Joomlapolis also offers some very light-weight and fast-loading Joomla
templates that have built-in support for Community Builder pages.
More info about these offerings is available here:
www.joomlapolis.com/joomla-templates

Installation Services

A variety of fixed cost services packages are available for your Joomla,
CB, or add-ons installation needs.
Joomlapolis Installation Services

By the hour
Professional Services

You can purchase on or more hours of training, technical, consultancy or
general support.
Joomlapolis Hourly Services

10
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What you see may be different

Community Builder runs as an extension on a Joomla CMS system. The illustrations in this guide
were taken from a Joomla 3.3.6 website with CB 2.0.5 installed. Therefore, some illustrations may
not look exactly like what you see on your computer display.

This book assumes that you have installed CB 2.1.4+ for the very first time on your
Joomla 3.8.6+ website. If you are upgrading to CB 2.1.4+ from a CB 1.9.1 environment
you may notice differences in your CB Configuration parameter contents and field/tab
titles because of the migration process.

Note

What are all these things called?

The terms used in Community Builder for most parts of the user interface (the parts of the program
you see and use, in contrast to the behind-the-scenes code that actually makes it work) are the
same as for most other Joomla extensions.

But there are some CB specific terms that a CB user should become accustomed with as early as
possible. The technical names for common CB elements are shown in Table 3.
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Table 3: Community Builder Terminology

Community Builder Terminology

A front-end page generated for each user that contains information about
CB User Profile this user. The data is formatted as CB Fields placed in CB Tabs. Users
can edit their profile data.

A specific area on a CB User Profile that contains one or more CB Fields.
CB Tab A CB Tab can be configured to appear in various profile positions and in
different layouts.

A piece of data associated with a specific user. Each CB Field is of a
specific type. E.g., text field, image field, date field, file field, etc. ACB

CB Field Field also has other characteristics. E.g., a field can be marked readonly,
not to be displayed on profile views, to appear during registration
process, etc.

Community Builder can be extended by installing CB Plugin packages. A
CB Plugin CB Plugin is installed using the CB Plugin Management page installer
and not the Joomla Extensions Manager installer.

A list of users with some specific to these users data formatted on a
CB User List front-end CB generated page. You can create as many user lists as you
want.

A front-end form that needs to be filled-out before a user is given a CB
User Profile and a Joomla user account on a website. The form may be
extended with CB Fields that can be filled-out during the registration
process.

CB Registration Form

A Joomla module that is installed by the Community Builder package.
This module lets users login and logout on your website and can be

CB Login Module configured to provide more information (e.g., show user avatar, link to
user profile page, etc.). This should be used instead of the Joomla Login
module.

A Joomla module installed by CB that show the current number of online
CB Online Module users and it can be configured to show much more also. This module
should be used instead of the built-in Joomla “Who's Online” module.

A Joomla module installed by CB that shows CB Users and CB
Moderators a list of pending actions that needs their attention. E.g., a
pending connection for the user, pending registration form approvals,
image approvals, user reports, etc.

CB Workflows Module

A connection between to users. The connection can bidirectional or
unidirectional and can be configured to require approval or not.
Connections can be characterized with one or more tags. E.g., Friend,
Co Worker, Family, etc. All connections of a user are shown in the CB
Connections tab on the user profile and can be managed or removed by
user.

CB Connections

There are more CB related elements that need to be mastered, but these are the basic ones that
you will run into during your first CB interactions.

Within the context of this book the prefix CB may be dropped from the terms in the
Note previous table. So user profile, tab, field, plugin, etc. will implicitly refer to the CB user
profile, CB tab, CB field, CB plugin, etc., unless otherwise stated.
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Frequently asked questions

How is Community Builder licensed?
Community Builder is distributed under the GNU Genral Public License v2. The GNU License
details may be seen at www.joomlapolis.com/gpl-terms.

May | distribute Community Builder to anyone? May | sell it? May | use it in my business?
Yes.

How many websites may | install it on?
As many as you like.

Is Community Builder available in my language?
Community Builder has been translated (localized) into many languages, so your language
probably is supported. Check here for your language:
www.joomlapolis.com/cb-solutions/languages

How can you make it for free?
Community Builder is developed and maintained by team of paid professionals and has the
backing of over 500,000 users on Joomlapolis alone. Its development is supported and funded
from donations, paid support and extra add-ons subscriptions and footer removal supporters.

How can | contribute to Community Builder?
You can help with the development and user support of Community Builder in many ways, and
you do not need to be a programmer. To start, check out the free forums on Joomlapolis and
help new users asking questions you can answetr.

May I distribute the PDF of this book, or print it?
Yes, as long as you meet the requirements of one of the licenses in the copyright statement at
the beginning of this book. You do not have to request special permission.

How do | remove the Powered by Community Builder footer?
Displaying such a footer on your website CB powered pages will attract more users to try out
Community Builder and thus increase the potential for more paid subscriptions and donations.
This is one of the means that help us keep Community Builder free. You can however remove
this footer from all your websites for a modest fee. More information about this can be found:
www.joomlapolis.com/community-builder-remove-footer

How do | develop my own CB Plugins?
We will be working on a more comprehensive development document, but in the meantime
your best approach would be to just study our CB plugin code and learn by example.

What happens to my paid for add-ons when my membership expires?
Everything distributed on Joomlapolis is GPL licensed. This means that things will continue to
work as usual even after your subscription expires. You can also install what you already
downloaded on more websites. The only implication is that when your subscription expires you
will no longer be able to get maintenance release or post on the support forums.
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Chapter 1
Introducing Community
Builder

Let's build up expectations


https://www.joomlapolis.com/community-builder

What is Community Builder?

Community Builder is a Joomla extension that helps you create and manage your very own —
tailored to your specific needs — social networking website.

It provides the framework and the tools needed to implement your specific social network use case
starting from the registration process, the data gathering, the moderation and most importantly the
empowerment needed to motivate your users to socially expand your network.

Community Builder is designed out of the box to render its front-end and back-end (administrative)
pages in a cleanly formatted layout that adapts to all viewing devices. It can be viewed on all
desktop, tablet and mobile device Internet browsers.

From a Joomla Perspective

Community Builder is distributed as a Joomla package that is installed using the Joomla
Extensions » Extensions Manager page. The package contains and automatically installs the
following Joomla elements:

Community Builder component
CB Login module

CB Workflows module

CB Online module

CB Library

CB Admin module

CB System plugin

N g bk w NP

Technical Prerequisites

Community Builder can be installed on a Joomla website environment that has the following
technical characteristics:

e Joomla 3.3.6 or better (Joomla 3.8.8 recommended)

e PHP 5.3.10 or better (PHP 7.0+ recommended)

* MYSQL 5.1 or better (MYSQL 5.5+ recommended)

* cURL and curl_multi_exec must be enabled on your hosting environment

* GD2 Library (optionally needed for image processing)

Sample Front-end Pages

Community Builder front-end pages can be configured to support your specific social community.
Its registration form, email sign-up messages, user profiles, user lists and more will help you build
a thriving online society.
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Registration Page

The CB Registration page can contain as many CB Fields as needed to help you categorize and

group your community members. One of the available layout options for the registration form is the
flat layout that is shown in Figure 3.

Join us!

Welcome to our community -itelllusiabout yourselfiand signiup:

First Mame

Last Name

Username

Email

Password

Verify Password

Gender

Birthday

Marital status

CB Expertise

Welcoming message

* &

* T

* &

* &

* @
() Male () Female @

v/ v/ 5

@

[ Community Buildern | GroupJive [ C
[ Query field [ Auto Actions(| C
[ CB Invites
.

* @

e

© Jan 4 2015 ¢ ©O
Su Mo Tu We Th Fr Sa
1 2 3
4 5 6 7 8 9 10
11 12| 13 14 15 16| 17
18 19 20 21 22 23 24

25 26 27 28 29 30

4

] Accept Terms and Conditions # >

Figure 3: Registration form — flat layout

31

Of course, everything is configurable. The Join Us! message, the tagline Welcoming message, the
fields on the form and even the splash image can be changed to your liking with parameter settings
or language plugin string overrides.

Chapter 1 Introducing Community Builder

17



The Registration Form can also be configured to follow a tabbed-based layout and display the
relevant CB Fields (that have been marked for inclusion in the registration form) grouped by their

CB Tab location as shown in Figure 4.

Join us!

Welcome to our community -tell us'about yourselfiandisigniup!

Contact Info Additional Info

Gender () Male () Female @
Birthday aly sy s g
Marital status @™
CB Expertise ("] Community Builden | GroupJive || CBSubs
(] Query field ] Auto Actions| | CB Connect
[ CB Invites
@&

Welcoming message *®
-

] Accept Terms and Conditions ¥ >

Figure 4: Registration form — tabbed layout

You can select the different registration form layout options from your

Tip

Community Builder > Configuration > Registration tab > Registration Layout
parameter. In order for this setting to work, you also need to have set the

Template Output parameter to Divs on the Configuration > User Profile tab.

And there is also a third layout option for the registration form to display the form in a stepped-base

format as shown in Figure 5.

18
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Join us!

Welcome to our community - tell usiabout yourselfiandisigniup!

Contact Info Additional Info

First Name w* @
Last Name w* @
Username * @
Email w* @
Password w* @
Verify Password @
Member Access Code * @

Next —

Figure 5: Registration form — stepped-base layout

You can inspect the page layout using your browser development tools (example
Tip Firebug) to see the CSS tags that are used and add extra stylings in your Joomla
template file to adjust to your liking (CSS skills needed).

Login Module

The CB Login module replaces the Joomla Login module and does much more to help your
community members feel more at home.

There are many built-in configurations that will let you easily adjust the module to your liking and to
you Joomla template position placement. For example Figure 6 shows the CB Login module in its
default bootstrap layout for vertical template positions.
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CB Login
&

Remember Me

Forgot Login?
Sign up

Figure 6: CB Login
module vertical layout

You can also adjust the CB Login module so it fits nicely in a horizontal layout template position as
shown in Figure 7.

CB Login (H)
F3 a Remember Me m Forgot Login?  Sign up

Figure 7: CB Login module horizontal layout

The Login module has many additional parameter settings that will help your users to quickly
participate and navigate on your website. Such an example is shown in Figure 8 where a logged in

user can see his/her profile image and click it to reach his/her user profile page and can also see if
unread private messages exist.

CB Login

Hi, admin

&= You have 3 new private
messages.

Figure 8: CB Login with
image to profile link and
private messages

You can inspect all the CB Login module settings from your Joomla Extensions »
Tip Module Manager page by selecting an existing CB Login module (or creating a new
module instance) and looking in the 4 Options tabs.

20 Community Builder 2.0 Primer



Users Online Module

The CB Online module can be configured in many different modes to help you highlight your
membership activities. Figure 9 shows you 6 different CB Online module mode possibilities.

Online Statistics

® Online Users: 1
Q Offline Users: 11
@& Guests: 0

Latest
Registrations

Themistoklis
Villy
Rena
Fenia
Paulina
Kyle
Beat
Anthony
Jennifer
Tom
Susan
Mick

Figure 9: CB Online module

Online Users

Nick

Latest Visitors

Mick
Tom
Rena
Susan
Jennifer
Anthony
Paulina
Beat
Kyle
Fenia
Villy

Themistoklis

User Census

&8 Total Users: 12

& Latest User: Themistoklis
@ Online Users: 1

f Users Today: 0

i Users this Week: 0

# Users this Month: 0

¥ Users this Year: 0

Latest Profile
Updates

Rena
Tom
Susan
Jennifer
Mick
Anthony
Beat
Kyle
Paulina
Fenia
Villy

Themistoklis

The names displayed in the CB Online module are linked to each user's CB profile page.

You can inspect all the CB Online module settings from your Joomla Extensions >
Tip Module Manager page by selecting an existing CB Online module (or creating a new

module instance) and looking in the Options tabs.
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User Profile Page

The User Profile pages are configurable and can be structured in many different ways to suite your
use case.

You have no established connection with 6 Request Connection

View = Edit = Messages = Connections ~ Moderate =

Articles @)  Blogs )  Forums

@ < Contact Info | =
Formatted susan Member Since
Name 3 months
Rate my profile @ Lt Oriling
Points 508 20 ceyo:pat

Last Updated
3 months ago

Powered by Community Builder

Figure 10: User Profile Page

User List Page

Letting your members search for other members is key to empowering your community to socialize
and grow.

You can configure as many user lists as needed and each one may be configured differently and
can also be searchable.
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all members

GCommunity Builder 2.0 has 12 registered members

all members y
member Dates Stats Additional
Member Since about a year ago Views 22 Gender Male
Last Updated 6 months ago Connections 3 Birthday -
Last Online 4 months ago Marital status Married
with Children
Anthony
Member Since about a year ago Views 27 Gender Male
Last Updated - Birthday -
Last Online = Marital status Married
with Children
Beat
Member Since about a year ago Views 13 Gender Female
Last Updated - Birthday January 01
Last Online - Marital status Single
Fenia
Member Since about a year ago Views 55 Gender Female
Last Updated 3 months ago Connections 4 Birthday January 01
Last Online 3 months ago Marital status Single
Jennifer
Member Since about a year ago Views 13 Gender Male
Last Updated - Birthday May 02
Last Online = Marital status Married
with Children

G<23,,,

Figure 11: User List table layout

User Lists can also be configured to be displayed in a grid layout.

The round profile images in the User List table layout sample of the figure can be

Tip configured and is discussed in Chapter 4 Working with Images.
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Grid layout

Community Builder 2.0 has 12 registered members

o © 6 0O

Anthony Beat Fenia Jennifer
@] o O o
! @L. . “‘- *?

e
Nick Paulina Rena Susan
o O O O
ey ‘
Tom Willy
o @]

Powered by Community Builder

Figure 12: User List grid layout

Grid layout ;

Search Users ~

Themistoklis
o

We will be exploring more user list topics later on in this book in Chapter 5 Working with User

Lists.
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5 COMMUNITY

Chapter 2
Installing Community Builder

Your getting started steps


https://www.joomlapolis.com/community-builder

Before You Install

Before you plunge in and install the latest Community Builder package on your Joomla website you
should take some precautionary measures.

Check Joomla Version

Before you attempt to install Community Builder on your Joomla website you should first check that
your Joomla version and the Community Builder version you intend to install are compatible.
Joomla technical requirements can be found here:
downloads.joomla.org/us/technical-requirements-us

Community Builder technical requirements can be found here:

Check PHP Version

Joomla 3.x requires a PHP version of at least 5.3.10+ (5.6+ recommended).

Check MYSQL Version

Joomla 3.x requires MYSQL version 5.1 or better (5.6.24 or better recommended). For additional
database possibilities and other technical requirements please check the Joomla Technical
Requirements page here:

http://www.joomla.org/technical-requirements.html

Check PHP upload_max_filesize parameter

The CB package is slightly more than 4 MB in size. This means that your PHP
upload_max_filesize parameter needs to be set to at least 6 MB (8 MB is recommended by
Joomla).

Check PHP post_max_size parameter

The PHP post_max_size parameter should be set to the same value as the upload_max_filesize
parameter. Joomla recommends that this is set also to 8M.

Check Joomla Directory Permissions

Before attempting to install any Joomla extension you should make sure that all your folder
permissions are writable (green). Only exception to this rule can be your configuration.php file that
may be Unwritable (read).

Backup First

The Internet is a dynamic environment. Server and bandwidth glitches may interfere with your
installation process and cause unwanted results. As a precaution you should always take a backup
before you attempt any new extension installation on your Joomla website.

You can check your Joomla version, PHP version, MYSQL Version, etc. from your
System menu > System Information tab area. You can also check your PHP variable
settings (example upload_max_filesize) from the System menu » PHP Information tab
area and your folder permissions from the Directory Permissions tab.

Tip
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Installation Methods

Joomla extensions are installed from the Joomla administration area » Extensions » Extension
Manager Page as explained in the Joomla documentation page here:

docs.joomla.org/Installing_an_extension

There are basically 4 methods that you can use to install Community Builder on your Joomla
website.

Upload Package File Method (Preferred)

If you have not already downloaded the latest Community Builder package from Joomlapolis you
should do so now by registering a free (or paid account) account and logging in so you can access
the latest CB Package from the Community Builder page:

www.joomlapolis.com/community-builder

If you are a free member you will be also able to download the latest Nightly Build package that
typically includes latest fixes rolled out by the CB Team to be included in the next stable release.
Otherwise, you can download the official stable release which would be CB 2.1.41 (or better) as
shown in Figure 13.

 COMMUNITY
\

Build your own community!
Simplify member registration
Let your members connect
Personalize profiles member lists
Scalable, reliable, robust
Hundreds of plugins available
It's free & open source - GPL

Get Ci;g}}low!

LA LA ALK A

O Free Download

Latest Nightly Build

Joomla3x 25

See Getting Started Articles
Free video tutorials

Figure 13: Downloading Latest CB
Package from Joomlapolis

1 CB 2.1.4 was the latest version released during the preparation of this book chapter.
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Your download package should read something like:

e pkg_communitybuilder_2.1.4+f26954917.zip for a stable release package

* pkg_communitybuilder_2.1.4+build.2018.03.08.19.14.41.a261fdeba.zip for a latest build
package

The specific version number, date stamp for latest build, and hash code may differ depending on
when you download.

To proceed with the installation, you need to click on the Choose File button on your Upload
Package File tab page and select the specific package you downloaded previously from
Joomlapolis and finally click on the Upload & Install button as shown in Figure 14.

Install from Web Upload Package File Install from Directory Install from URL

Upload & Install Joomla Extension

Extension package file Choose File | [ pkg_communitybu...zip

Upload & Install

Figure 14: Upload & Install Joomla Extension

If all goes well you should see the green Joomla Installing Package was successful message and
the Community Builder splash screen as shown in Figure 15.

Message
Installing package was successhu.,
o conmnty 05
Update .
2% AT POWERED BY
Manago i »
-  COMMUNITY
Discover \
Database j
Warnings —
inatel lngumone Copyright 2004-2014 Joomlapolis.com. This component s released under the GNU/GPL version 2 License. All copyright

statements must be kept. Derivate work must prominently duly acknowledge original work and include visible online links.
Installation done.
Now is a great time to checkout the Getting Started resources.

cx hone 10 b mone CB Pluging (Languages, Fisids. Tabs, Signup-Connect, Paid Membarships and over 30 mong) by CB Team a2 joomiapolis com

c
Click here 10 soe our CB listing on the Joomial Extensions Directory (JED) and find thind-party add-ons for your website.
8 Start to Configure Community Bullder

Figure 15: Installation done CB splash page
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Install from WEB Method

From your Joomla administration area Extensions » Extension Manager Page select the Install
From WEB?2 tab and type Community Builder in the search box.

Install from Directory Method

You can manually unzip the CB package and upload it to a folder on your Joomla hosting
environment and then use this method to install the package.

Install from URL Method

This method does not apply to CB since there is no public URL with the CB package on
Joomlapolis.

2 At times this service may not be available due to maintenance reasons on the Joomla Extensions
Directory website.
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Inspecting Your New Installation

After successfully installing Community Builder you can inspect what Joomla elements have been
installed and how these are presented on your Joomla website.

Joomla CB Elements

When you visit your Joomla Extensions » Extensions Manager Manage Page you should see
many Community Builder related elements (just search for Community Builder so see them listed)
with author CB Team as the are shown in Figure 16.

Community Bullder Q X 20 -
Hame = Location Suatus Type Version Date Author Folder 1+]
Community Builder Adrministrator - Componnt 205 2015-01-22 8 Teamn MR 10002
Cormemunity Bullder Adrmin module Adrminiatrator v Maoduo 205 2050022 €8 Teamn N 10006
Cormmunity Builder Litwary S v Libbrary 205 2015-01-22 CB Team M 10159
Comenursty Builder Login module S ¥ Modue 208 2015-01-22 CB Tearn WA 10003
Cormemunty Builded Oriling module St v Madula 205 2015-01-22 CB Tearn N 10004
Comemarty Builder Packags Ste " Packagy 208 2015-01-22 CB Toeam M 1000T
Community Builder System plugin St v Plugin 205 2015-01-22 C8 Team systern 10001
Community Bullder Workdfiows madule St v Maodule 205 20050122 CB Team N 10005
Cortort - Comemunity Bullder Ste o Plugin g 2014-11-13 Kordgon content 10026
Conbert - Community Bulder Author S v Plugin 200 2014-09-29 Krdoon conderd 10023
Kunena - Communty Bullder Integration St v Phugin ans 2014-07-28 Kunona Toam Kunsna 10053
Search - Community Builder Site o Phugin 201 2014-10-21 Krilgon search 10024

Figure 16: Community Builder Joomla Elements

These elements are briefly explained in Table 4.

Table 4: New elements present after Community Builder package installation

Elements you will see on your Joomla site after CB installation

Community Builder
Package

The Community Builder Package is what was initially installed on your
Joomla website (remember the upload file was named pkg ).

Community Builder

This is the Joomla component that the CB package installed.

Community Builder
Admin Module

Administrative module responsible for the new Community Builder menu
and the CB News/Update areas you will see in the Joomla Control Panel.

Community Builder
Library

The CB framework as a Joomla Library.

Community Builder
Login module

Areplacement to be used instead of the Joomla Login module.

Community Builder
Online module

A replacement module to be used instead of the Joomla Online module.

Community Builder
System plugin

A Joomla plugin that handles the redirection of any Joomla login or
registration requests to the relevant CB pages.

Community Builder
Workflows module

The CB Workflows module that will enable CB Moderators to handle
requests for new approvals, image uploads and user reports.
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Community Builder Joomla Navigation Menu

After you install the CB Package you will see a new Community Builder menu addition to your main
Joomla Navigation menu strip just to the right of your Help menu item as shown in Figure 17.

Extensions ~ Help ~ Community Builder ~ Paid Subscriptions ~ GroupJive ~

Control Panel
User Management

Tab Management
llation messages

Field Management
st-installation messages that req 9

those messages please click on the Review !

List Management
ssages at any time by clicking g jtallation messages menu item of your site’s &

ippear when you have hidden al Plugin Management
Tools

Configuration
Credits

Figure 17: Community Builder Menu

This new menu gives you quick access to Community Builder administrative pages, but you may
also use the Community Builder menu entry that also appears in the Components menu.

The Paid Subscriptions and GroupJive menu items will automatically appear when

Note you install CBSubs or GroupJive (paid membership needed).

Site Community Builder Menu

A new Community Builder menu has been created and populated with CB specific menus as
shown in Figure 18 and Figure 19.

System ~ Users + Menus + Content + Components -

i
> Control Panel Menu Manager

Community Builder

Main Menu & ju have post-install:
ere are important post:

CONTENT

Z  Add New Article User Menu
ol can review the mess

@ Article Manager information area won't ap

Figure 18: Site Community Builder menu
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Community Builder v - Q Search tools » Cloar Ordieding ascending *| |20

Status Title Home Access Language D

] e CB Moderate User Approvals (ARs: co-moderale-user-approvals) Publc Al 128

derate Repors (Ales: cb-moderate-reports) Publc Al 127

] v CB Moderate Images (Akes: ch-moderate-images) Pubkc Al 126

H v G e Bans (Akas: cb-moderate-bans) Publc Al 125

H v CB Manage Connections (Alas: ch-mansQs-Connactions) Publc Al 124

I v C o Publc Al 123

I - 5 ch-forgot-iogin Pubic Al 122
Community Bulider

i v Cl t A o) Pubic Al 12
Cormmunty Bulde

i = ¢ i (AkSS: Cb-log Publc Al 120
Communiy Bulider

i v C Publc Al 119

i v C Publc | 118

I v Publc 1 "7

Figure 19: Community Builder site menu entries

You can move these menu items to other menus on your website or you can just create
Tip new alias items pointing to these. You can also create new CB related Joomla site menu
items from your Joomla Menus menu page.

Caution All Joomla menu items in Figure 19 are published for Public viewing. You should not

change this unless you are absolutely certain of the implications. For example, if you set
‘ the CB Profile menu to Registered, then Joomla will not give public access to the CB
Registration form which means that your registration process will not work.

/a\

New Community Builder Module Instances

When you install the Community Builder package on your Joomla site for the very first time along a
number of module instances are also created.

You can view the front-end module instances by visiting your Joomla Extensions » Module
Manager page and searching for names that start with CB with the filter set to Site. This is shown
in Figure 20.

As you can see there are three instances created, one module instance for each of the Community
Builder Login, Workflows and Online modules.
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¥ Module Manager: Modules ! Joomlal

BT | ki || Ooupicm ||+ Publish || © Unpubiish || B Checkin || B Trash || [ Batch © Help || O Options
Sty
= cB a x Pesition v || Ascending v |20
Administrater
s Status  Titla Position = Type Pages: AGoess Language 1D
Filter: +| = | CB Login Community Al Public A ar
Buikder Login
Site X - modui
 Selact Sratue - | = | CBWarkflows Comiruity Al Rogetersd Al 89
Buider
Workflows
- Select Position -+ reduin
» | = | CB Online Community A Public Al as
- Sedect Type - v Builder Online
e
- Select Access -
- Select Language - ~

Figure 20: Front-end CB Module Instances

These site module instances when configured, properly positioned according to your Joomla
template and published will output content similar to that of Figures 6, 7, 8 and 9.

You can create more CB module instances from your Joomla Extensions » Module
Tip Manager page by clicking on the New button and selecting the appropriate module
name from the list.

There are also 4 module instances (each one configured differently) of the Community Builder
Admin module that you can see by setting the filter to Administrator and the Type to Community
Builder Admin module as shown in Figure 21.

¥ Module Manager: Modules “ Joormlal

“ B B D Duplicate |+ Publish | @ uUnpubiish | MCheckin | T Trash | [S) Baon ©Hep | 0 Options
Site
a A Poasition v || Ascending v| 20 =
| Admicetater |
Status  Tithe Position = Type Pagos Access Language 1D
Filter: ¥ = | Community Builder Nows [ cpans | Commurty M Pubic u #
. Baddor Admin
Administrator x - mosuls
o Yoo v v Comemunity Builder Updates m Cornmunity AJ Publc Ad a2
Bulder Admin
module
- Select Poaition -
v = | CB Admin Voersion Checker [ cpane | Cartrrunty ] Pubic A a
Badder Admin
Community Buide... ~ moculs
- Select A - ~| = CB Admin Dropdown Menu m Cormemunity Al Pubic Al a0
Bodder Admin
rocule
- Select Language -

Figure 21: CB administration module instances

One of the CB Admin module instances is used to render the Community Builder menu shown in
Figure 17, a second one is used to render the CB version checker on the Community Builder >
Control Panel page and the Community Builder » Configuration page. Finally, the 2 remaining
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module instances are used to render the News and Updates blocks in the Joomla System >
Control Panel page as shown in Figure 22.

COMMUNITY BUILDER NEWS COMMUNITY BUILDER UPDATES

Thin o fully s Your install is up to date.

Community Builder 2.0

l Tha Next Generation Community
Builder 2.0.0 was released 4 months
ago. Since then we have been working
on many fronts to reaffirm operational
robustness and security, to increasa
our add-ons compatib...

= MNew Template Releases for CB
2.0

MyCommunity - Coolness - Funlite -
FlexistrapOur 4 Joomlapolis Templates
arenow CB 2.0 Compatible --- Qur 4
super-fast and light-weight Joomila
2.5/3.x templates have been
bootstrapped and updated fo...

|

"y
| -
A tl"

Figure 22: Appearance of CB module instances on Joomla control page

Community Builder System Plugin

The Community Builder System plugin can be found in the Extensions Plugin Manager page and it
should be published by default.

This Joomla system plugin is needed to handle various URL redirections and URL parsing. You
can inspect the Parse URLs tab parameters to see the relevant settings as shown in Figure 23.

& Plugin Manager: Community Builder System plugin

o samsioss || © Gise || ©

Plugin Parse URLs
Redirect URLs Enabled v
Rewrite URLs Disabled v
Pass Return URLs Enabled v
ltemids Disabled v

Figure 23: Community Builder system plugin

If you have SEF enabled on your Joomla site you might have to enable all Parse

Note URLSs tab parameters
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After Installation Getting Started Steps

The installation splash screen shown in Figure 15, prompts you to check out the Getting Started
resources on Joomlapolis. Please visit these short articles now and follow the instructions they
provide.

For the seasoned Joomla users reading here is a high level series of reminder steps that you need
to take care of when you install Community Builder for the first time on your Joomla website:

1. Configure Community Builder Name Style, Date Format, Allow User
Registration, Fields validation in User Management and Template
Output parameters

Turn off Joomla registrations

Turn off Joomla emails to new users

Configure and publish your CB Login module
Unpublish your Joomla Login module

Configure and publish your CB Workflows module

Configure and publish your CB Online module

© N o 0 R~ W DN

Unpublish your Joomla Online module

If these descriptions are not sufficient then by all means visit the Getting Started articles by clicking
on the following URL.:

http://lwww.joomlapolis.com/documentation/community-builder/getting-started

If you are a visual learner you can visit our Community Builder 2.0 Video Tutorial series (over 40
short sessions) by clicking on the following URL:

http://www.youtube.com/playlist?list=PLpOpuRITgC7PuyzPsMUECDI46VE7IFSAX
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Updating from Community Builder 1.9.1

If you are updating from a CB 1.9.1 installation there are some special precautionary steps that you
should follow:

Tip

Take a full backup and if possible perform the remaining steps on a cloned environment

Make sure your existing CB Plugins are CB 2.1.4+ compatible. Most likely they will not be,
so you need to have new versions at hand to upgrade them also after your CB 2.1.4
upgrade.

Unpublish all non core CB Plugins, even the ones you purchased from Joomlapolis in the
past. This will ensure that your CB upgrade process will not be affected by incompatible old
add-ons attempting to access API function calls that might not be available in CB 2.1.4. If
you have CBSubs installed then also unpublish the CBSubs Joomla plugin.

Install the latest CB 2.1.4+ package. Hopefully, everything will complete without problems. If
any issue appears then seek help on the free/paid forums on Joomlapolis.

Run all CB Tools to make sure everything is green. If needed follow any fix
recommendations reported by CB Tools.

Update all extra CB Plugins (previously unpublished) to their latest CB 2.1.4+ compatible
release.

Publish the now upgraded CB Plugins.

If process was done on a cloned environment, redo on live environment.

You can watch the tutorial #30 of the CB 2.0 Playlist series that actually demonstrates
the upgrade process:

https://www.youtube.com/watch?
v=AtMsAhScimg&list=PLpOpuRITgC7PuyzPsMUECDI46VE7IFSAX&index=30
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Chapter 3
Working with Fields

The building blocks of your profiles


https://www.joomlapolis.com/community-builder

What is a CB Field

A Community Builder Field is an entity that holds user specific data.

Field Properties

Each CB Field has the following general properties:

e Title

° Name

e Description

* Publish Yes/No status

e Type

e Tab

* Required / Not Required status

e Read Only Yes/No status

e Show on Profile

* Show on Registration

e Default Registration Value
e Show on Profile Edit

* Searchable Yes/No status

e Size

* Ordering

® (CSS Class

Some field types may have additional general properties. E.g., the Integer Number type field
has a Maximum Length property and the Text Area type field has Columns and Rows

properties.

The Show on Profile, Show on Registration and Show on Profile Edit properties
can be configured to one of the following 5 settings:

. No

1 Line with Title

1 Line with Empty Title
1 Line without Title

2 Lines with Title

. Yes,
. Yes,

. Yes,

u s W N

. MESsy

Figures 24 through 27 show you how a text field would display on the registration form when

configured to one of these options.

Verify Password * &

My First Text Field &

Figure 24: Registration layout setting Yes, 1
Line with Title

Verify Password * &

@&

Figure 25: Registration layout setting Yes, 1
Line with Empty Title

Verify Password

@&

Figure 26: Registration layout setting Yes, 1
Line without Title

* @

Verify Password

My First Text Field

@&

Figure 27: Registration layout setting Yes, 2
Lines with Title
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Some of the field layout setting options might seem inappropriate (and they are for the
text field type). Their value will become much clearer when combined with the
placeholder parameter and other field types (e.g., text area or editor field types).

In addition to these 4 field layout settings you can do much more creative field layout
handling with the advanced parameters located in your field Parameter Layout sub-tab.

Field Types

Your default Community Builder installation has 24 built-in field types (Type parameter) that you
can use when creating CB fields. In alphabetical order these are:

1. Check Box (Single)

2. Check Box (Multiple)

3. Date

4, Time

5. Datetime

6. Drop Down (Single Select)
7. Drop Down (Multi-select)
8. Email Address

9. Editor Text Area
10.Text Area

11.Text Field

12.Integer Field

13.Radio Buttons

14 .Web Address

15. Image

16 .Password

17.Custom HTML

18.File

19.video

20.Audio

21.Rating

22.Points

23.Terms and Conditions

24 .Forum Status

membership offering.

There are extra field types that can be added by installing extra CB Field plugins. E.g.,
the CB Query field and the CB Progress field add-ons that are part of the Professional

Chapter 3 Working with Fields

39



Core CB Fields

By default every new CB installation has 19 predefined CB fields.

Properties
Name Title Type R P R E S P
e r e d e u
q o g i a b
Terms and Terms and
acceptedterms Conditions Conditions * * x x % v
Profile
avatar Image Image X v X |v(1 | X v
canvas Canvas Image Image X (vl | X (v | X v
connections Connections Connections X (v | X x x v
. . Email address
email Email (main) v X (v vl | X v
Predefined name
firstname First Name and username v X v (vl | X x
fields
formatname Formatted Formatted name x vil| X x X v
Name
hits Views Counter b viz| X x X
Predefined name
lastname Last Name and username v X (v vl | X x
fields
lastupdatedate Last Updated Datetime X vz X x X v
LastvisitDate Last Online Datetime x vz | X x x v
Predefined name
middlename Middle Name and username x X vil (v | X x
fields
Predefined name
name Name and username v x vl |v(1 | & v
fields
onlinestatus Online Status Online Status X v | X x x v
arams User User parameters x x x v (1 x v
P Parameters P
password Password Password v X v (&1 | X v
pm PM Private Message | X x x x x v
registerDate Member Since Datetime X v | X x x v
Predefined name
username Username and username v X (v vl | ¥ v
fields
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Don't be alarmed if the properties of your fields do not exactly match the ones listed. CB
Note Configuration parameters may influence some property values. E.g., the name fields
depend on the Configuration Name Style parameter setting.

Field Parameters

By default every CB field has a Parameters tab that contains more settings for the field. These
settings are further organized in sub-tabs.

Global Parameters

Layout Display Validation

Profile Value Layout

o
P
Profile Edit Value Layout
i)
P
Userlist Value Layout
i)
P
Registration Value Layout
i)
P
Prepare Layouts using Content Plugins Yes i)
Icons Display Normal CB Default + O

Figure 28: Field Parameter sub-tabs

In most field type cases you should expect to find, as shown in Figure 28, the following three sub-
tabs under the field Parameter tab:

1. Layout
2. Display
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3. Validation

For most field types you will see the Layout, Display and Validation sub-tabs. However,
there are specific field types that might not have these or might also have extra sub-

Note tabs. Take a look at the Parameter sub-tabs for image type fields or file type fields as
examples.

Layout Sub-tab Parameters

The parameters on the Layout sub-tab let you influence the way the field is displayed in various
Community Builder pages, basically extending the built-in default views.

There are 4 layout specific parameters on the sub-tab:
Profile Value Layout

Profile Edit Value Layout
Userlist Value Layout

A

Registration Value Layout

Each one of these text area parameters can be used to alter the way the field is rendered in
specific CB views. You can insert HTML code and CB field substitutions in this process. The
substitution [value] is used to reference the default value of the field.

Here are some samples you can experiment with on a CB text type field that is used to store a
user's nickname. On the field's Profile Value Layout parameter try one of the following:

1. My nickname is <strong>[value]</strong>
2. My username is <i>[username]</i>, but you can call me <b>[value]</b>

3. [username]'s nickname is [value]

This is a very powerful feature that you can use to adjust the way any field is displayed on specific
CB pages (profile view, profile edit, user lists, registration).

Ti The Joomlapolis Youtube channel has various tutorial examples about CB Field Layout
Ip parameters. More help can be found on the free or paid forums on Joomlapolis.
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Display Sub-tab Parameters

For most field types there is typically only one parameter in this area, the Placeholder Value that is

used to specify the HTML placeholder attribute value that is shown in field edit mode.

You can experiment with this parameter by giving it some value (e.g., hickname goes here) and
then seeing how this value is shown in the field box during profile editing.

N Try creating different types of CB fields and seeing what field type specific parameters
ote appear in this sub-tab. E.g., look at the date field parameters.

Validation Sub-tab Parameters

Once again the presence and parameter contents of this sub-tab depends on the specific field
type. The text field type initially has the following 4 Validation sub-tab parameters:

Minimum length
Authorized input (drop-down selector that may display additional parameter inputs)

Forbidden words at registration

N

Forbidden words in user profile edits

Each one of these parameters has its own tooltip explanation to guide you.

N Experiment with other field types to see how this area adjusts itself. E.g., the Drop Down
ote field types do not have this sub-tab, the Date field types have different parameters, etc.

The Joomlapolis Youtube channel has various CB Field creation tutorial examples that
Tip you can watch and get the hang of things. More help can be found on the free or paid
forums on Joomlapolis.

Chapter 3 Working with Fields

43






-2 COMMUNITY

o

Chapter 4
Working with Images

A picture is worth a thousand words
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Introduction to Image Fields

The image field type is one of the 23 types available in Community Builder. This book will not have
a dedicated chapter for each of these field types, but image fields have a big impact on the overall
appearance of your CB website and for this reason we are exploring these here in more detail.

Built-in Image Fields

Looking back at the list of Core CB Fields that are created during the CB installation process we
notice that there are 2 Image field types:

1. avatar
2. canvas

As these are 2 highly visible elements on our user profiles, it is worth while to take a closer look at
both.

Edit = Connections =

L) Articles @  Blogs @

Contact Info

Figure 29: Default avatar and canvas rendering

In Figure 29 we see how these two image fields initially appear when viewing the admin's profile on
a new CB installation. The gray image is the default canvas image and the shadow person image
is the default (empty) avatar image.

Let's first focus on the canvas field and take a look at the details of this field in the CB Field
Management pages. As seen in Figure 30, the canvas image field has 5 Parameter sub-tabs:

Layout

Image limits
Image Gallery
Image Display

o~ w0 NP

Terms and Conditions
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Actually the first thing that someone will notice is that the Title of the field has changed from
Canvas Image (when viewing the CB Field Management summary page) to the string
USER_CANVAS_ IMAGE_TITLE (when viewing the field parameters). This is just the default
language string that is used and such matters will be discussed later in this document.

»  USER_CANVAS_IMAGE _TITLE L]

Name canvas @

If left empty, the default settings from global Community Bullder configuration will be taken. Other
settings, like images-library, systematic resampling and so on is done in the CB global

configuration.
Allow Upioad Disable ©

Aways Resample Normal CB Defaut 3 ©
Maximum Image Height 840 i
Maximum Image Width 1280 L
2 O
ball Height 320 0
640 o

Aspect Ratio Normal CB Default 3 ©

Upload Approva Normal CB Default 3 ©

Figure 30: Canvas field Image limits parameters

In the Image limits sub-tab there are some parameters that are set to Normal CB Default.
There are also some parameters that have empty (blank) values.

In both cases, such settings will fall-back to values that where configured in the CB Configuration
pages.

These default values are picked-up from the Community Builder » Configuration > Images tab
area as shown in Figure 31.

By default the canvas and avatar fields are configured to let users upload image files to them. See
the Allow Upload parameter setting that is Enabled. If you set this to Disabled you will see that all
the followup parameters will disappear as they are only relevant if uploading is enabled.

In many cases image field size parameter settings depend on your Joomla template and
the logical space allocated for the image. You should experiment with image size

Note parameters and properly configure your image fields as soon as possible as the settings
cannot be applied retroactively on already uploaded images.
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General Registration User Profile Images Moderation Connections Integrations

Image Software GD2 » ©

Always Resample Image Uploads Yes No @

Default Maximum Image Height 500 Li]
Default Maximum Image Width 200 Li]
Default Maximum Image Filesize 2000 i}
Diefault Maximum Thumbnail Height 86 i}
Diefault Maximum Thumbnail Width 60 Li]
Maintain Aspect Ratio Yes : 0

Figure 31: Default Image parameters

Image fields have size settings that influence a normal image and thumbnail image.

The Height and Width related parameters represent pixels and the Filesize kilobytes. Once again
the tooltips should be viewed when in doubt.

Maintain Aspect Ratio Parameter

The Maintain Aspect Ratio parameter is important to help resize user uploaded images so they can
blend in with the space allocated for them. The parameter has the following 4 possible settings:

1. Normal CB Default (means value will be taken from similar parameter of the CB
Configuration » Images tab)

2. Yes (means that the original image dimensions will be proportionally preserved when
resizing during upload for normal view and thumbnail view image sizes)

3. Yes, with cropping (means that dimensions will be preserved during upload resizing
and extra cropping will take place to get exact size images)

4. No (means exact size images will be created during upload but images might be stretched)

To illustrate the implications of these settings lets see the results of resizing a sample grid squared
image to dimension settings height=50px and width=150px with the three Maintain Aspect
Ratio options. The goal is to produce a resized image to our desired rectangle dimensions of
150x50.
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Yes produces 50x50

Yes, with cropping produces 150x50

Original Image 200x200
No produces 150x50

As you can see the 2 settings that produce the exact rectangle are:

* Yes, with cropping (preserves the proportions so result has squares in it)

* No (stretches and squishes the squares)

If you want your images to be scaled to exact dimensions you need to set the Maintain
Tip Aspect Ratio parameter to either Yes, with cropping or to No. The latter setting will
produce exact size images with distorted looking results.

Approval Upload

Any CB Image field can be configured to require approval before it is visible on CB pages. This
setting can be configured to:

* Normal CB Default
* Yes
* No

When set to Yes, images uploaded by users for this field will be put in a pending approval status
until a CB Moderator manually approves them. This approval workflow is managed through the CB
Workflows module.

Not Users that are CB Moderators are obviously exempt from approval processes and any
ote images they upload are immediately visible.
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Image Gallery sub-tab

The Image Gallery sub-tab lets you configure things so your users (in addition to or instead of
uploading and image) can select an image from a predefined list (gallery) of images.

By default, when you create a new image field, the Image Gallery sub-tab of the field will have its
Allow Gallery parameter Disabled. When you enable this parameter, as shown in Figure 32, you
will see an extra Path setting requested.

Global Parameters

Layout Image limits Image Gallery Image Display Terms and Conditions

Allow Gallery =HEGCM Disable | ©

Path Li]

Figure 32: Image Gallery settings

If this is left empty (blank), then the built-in avatar gallery will be used, These gallery images are
located in your Joomla root path /images/comprofiler/gallery where you will see a set of 28 files
that represent the full-size and thumbnalil size images.

Table 5: Free support for Community Builder users

Filenames Gallery Images

cartoon_bear.png

cartoon_beaver.png
cartoon_cat.png

cartoon_dog.png

cartoon_elephant.png

cartoon_elk.png

cartoon_gnu.png

cartoon_goat.png

cartoon_kangaroo.png

cartoon_mouse.png

cartoon_owl.png

cartoon_penguin.png

cartoon_sheep.png

cartoon_squirrel.png

14 thumbnail images
prefixed by tn
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By inspecting the Path tooltip you will see that the canvas field Gallery is located in the
fimages/comprofiler/gallery/canvas folder.

You can create your own image gallery by dropping your own set of image files (and
thumbnail files) in a new folder on your website and set the Path parameter

Tip appropriately. The filenames will be used in the title tag of the image with the first letter
capitalized and the underscores replaced by spaces. So the filename
cartoon_squirrel.png will produce an image with a title of Cartoon squirrel.

Image Display sub-tab

The parameters in this area let you further configure the styling of the image and also the default
images to be shown in empty image or pending approval situations.

As you can see in Figure 33 some parameter options default to Normal CB Default settings and
can take the values set to the relevant parameters in the CB Configuration pages.

Global Parameters

Layout Image limits Image Gallery Image Display Terms and Conditions
Style Rounded Bordered | ¥

Pending Default Normal CB Default 5+ @

Empty Default Normal CB Default 5 @

Alt Normal CB Default 5+ @

Title Normal CB Default + @

Figure 33: Image Display sub-tab parameters

The Style parameter can be set to one of the following 5 options:

None
Rounded
Rounded Bordered (default)

Circle

o bk w0 Dnh e

Circle Bordered

You can experiment with this setting and see how the image is rendered.
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In Figure 34 you can see how this setting affects our squared grid image rendered for each of the 5
options.

e e e o0 o

Figure 34: Style options for image field

The Pending Default and the Empty Default parameters are used to configure what images CB is
to show in these 2 situations. Before a user uploads an image for a CB image field, a default empty
image is needed and if the CB image field is configured to require moderator approval, then a
pending approval image is needed.

These 2 settings are configured from a drop down selection from the following list of available
options:

Normal CB Default
No image

nophoto f.png
nophoto m.png
nophoto n.png
pending f.png
pending m.png

© N o A~ DN

pending n.png

The 6 filenames in this list are picked up from the default CB template plugin folder
Tip located in /components/com_comprofiler/plugin/templates/default/images/avatar path.
The canvas image parameters look in the ../images/canvas folder instead.
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Working with User Lists

Your white pages directory
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What is a User List

A CB User List is exactly what you would expect. It is just a list of users displayed by Community

Builder.

Such a list can be configured to:

display data from CB fields for each user
filter users based on specific CB field criteria
be visible only for specific Joomla ACL views
appear as a table list or in a grid layout

be searchable by viewers based on one or more CB field criteria

We will be exploring these concepts in the remainder of this chapter.

Creating a User List

To create a CB User List you need to access the CB User List page from the Community Builder
menu and click on the New button. You can of course directly select the Add New List menu item
from the Community Builder menu. In both cases you will see a page like the one shown in Figure

35.

" Savek Closa + Save & New 21 Save as Copy @ Cancal © Help
Title [i]
Global Sorting Filters Columng Parameatars
Description Publish
[Toggle Editar] Al Mo O
L7 B I U5 HEEZJ 4 Puageph = Stes oire 4t ]
- Default
Fontfamily = Fontsize =« A<+ « K [EOEBE. E-=2-4# &
S0k Sl InITY | A Yes [N
= 5 B . ke
Tl S sE viod Access Level
Public
Li]

Usergroups

=== Salect User Group (C
Public
| Guest
| Manager
| | Administrator
| Registered
| | Author
| | | Editor
Path: p Words:0 . 11| Publisher
o | Super Users
[} Article i Image " Page Break ¥ FRead More i

Figure 35: Creating a User List

You first need to give your list a title and a description. Both will be displayed on the CB User List
pages of your website, so choose these carefully. You can of course always come back and make
changes if needed.
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The Global tab also lets you configure if the list if published or not, if it is a default list or not (there
can only be one default list), the Joomla Access Level views that can see this list and the Joomla
user groups that will be used as a first screening of users that will actually appear in the list.

You can study the tooltips of these parameters for more information and as you can see there is
also a Help button on this screen that you can click on to access the relevant help screen.

Sorting a List

The Sorting tab of your user list configuration lets you configure the order of appearance of users
on the list.

There are 2 configuration methods to choose from in order to define your desired sorting order.
The Basic and Advanced modes. Once again the tooltip icon is your friend and will help you with
the settings.

By default each list is set to a Basic mode ordering by ascending usernames.

Filtering a List

In addition to the first level of filtering that was selected using the Usergroups selector in the
Global tab of the list configuration, there is another level of filtering.

Once again there is a Basic and Advanced mode that can be used to configure this extra filtering.
Check the tooltip icons for assistance.

Using Columns to specify list contents

One of the most important aspects of any list is its contents. The Column tab in a user list
configuration is used to configure the list contents.

In order to illustrate how the Column tab configuration works, we will replicate the process used to
generate the CB User List shown in 23.

Ouir list has 4 columns that are named:

member
Dates
Stats
Additional

N

The member column is configured to show 2 CB fields in the list column:

* Profile image (avatar) on one line without a title

* Formatted Name (formatname) on one line without a title

The final configuration is shown in Figure 36.
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B Profile image = | 1 Line without Title . =

msmbar Li]

Formaned Nama - 1 Lina without Titie B - L n n

an

[
-]
A

Figure 36: Member column

The Dates column is configured to show 3 CB fields in the list column:
* Member Since (registerDate) on one line with a title
e Last Updated (lastupdatedate) on one line with a title

e Last Online (lastvisitDate) on one line with a title

This is shown in Figure 37.

- 1 ah T N
Dates 0 - Membar Sinco - 1 Ling with Title - ﬂ
4 30 & Last Updated b 1 Line with Thie S n
: =
G55 Class
[i] o ) 1 ’ - a
s Last Oniine - 1 Lina with Title s LL

Figure 37: Dates column

The Stats column has 2 fields:
* Views (hits) on one line with title

e Connections (connections) on one line with title

Titke
= o L) v - litevmme ¢ (BB

s
20 L) Connections - 1 Line with Title & = [i] n n

o

Figure 38: Stats column

And finally the Additional column that has 3 fields that were created manually after our CB install:
* Gender (cb_gender) one line with title
* Date of Birth (cb_bdate) one line with title

* Marital status (cb_status) one line with title
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This is shown in Figure 39.

- Ganice 11k N -l - .
Additional 0 H Gender - Line with Title — =
320 : Date of Birth « || 1Line with Tle ¢ ﬂ
=
CS5 Clnss
L = Aarital stat 1 Ling with Tt .
] Marital status - Lina with Title s Li]

Figure 39: Additional column

If you have been closely looking at the 4 column figures, you might have noticed the Size
parameter that is given the values 2, 4, 3 and 3.

This settings helps configure the column spacing of our list. The tooltip on the Size parameter
gives us an explanation. The Bootstrap layout CB is using is divided into 12 units. So our total list
will consume 12 bootstrap units when it is rendered. We have given our columns Size parameter
settings based on our anticipation of their content width and we have made sure that the sum of
our 4 settings is 12.

Experiment with the Size parameter of your list columns to see how it influences the list

Tip rendering. You should be able to get the hand of this and make it work for your user lists.

User List Parameters

Each user list has additional settings in its Parameters tab. In fact this tab has 4 sub-tabs:

Search
Display
Paging

i A

Linking

These tabs contain various parameter settings that can be used to configure a user list to be
searchable (which fields and how searching is to work). There are also settings that adjust the
display and the paging of items on a list.
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Search
This sub-tab has 4 parameter settings that can be used to configure a user list to be searchable.

The first parameter in the sub-tab is the Searchable fields setting that can be configured to
one of the following:

No
Searchable fields, displayed ones only
All searchable fields

A

Specific searchable fields

These options are self-explanatory and are basically used to configure which searchable fields can
be used for the user list's search criteria.

Every CB Field has a Yes/No Searchable property that will always be enforced. This
Note means that if a field is not set to be searchable then you will not be able to select it as a
search criteria in a user list, even if the field is displayed on the list.

There are a number of video tutorials in the Joomlapolis Youtube channel that give user

Tip list examples and search setup configurations.

The search criteria parameter for a list can be set to:

1. Simple Exact match: Only 'and' and ranges

2. Simple Any word match: Only 'any of' and ranges (WARNING: can be
slow)

3. Advanced: all possibilities (WARNING: can be slow)

Once again these settings are self-explanatory, but feel free to experiment and see how they
influence your list searching.

There are 2 more Yes/No settings in this sub-tab. The Hide Empty Searches and the
Collapse Search Criteria parameters. Tooltip popups are your friend here.
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Display, Paging and Linking User List parameters

The remaining 3 sub-tabs on the user list Parameters tab are:

1. Display
2. Paging
3. Linking

The Display sub-tab has a series of Yes/No settings that once again are simple to understand with
the help of the tooltip help popups.

The most important item here that should be understood is the Use Grid Layout parameter. By
default this is set to No and the resulting list is rendered in tabular form as is the list shown in
Figure 11.

The Use Grid Layout parameter set to Yes is how the user list in Figure 12 was
Tip produced. You can see this configuration once again in a relevant video tutorial on the
Joomlapolis Youtube channel.

The Paging parameters let you adjust if list paging is enabled and how many items per list page to
display.

The Linking parameters let you link each list item to the relevant user profile.

Joomla Menu Link to specific CB User List

Your default Joomla menu for CB User Lists will display the default user list and also a drop-down
list selector that lets your users switch to view a different user list (if available).

You can also create a new Joomla menu that is directly attached to a specific CB User List.

There are such examples in our CB 2.0 Tutorials playlist on the Joomlapolis Youtube

Note channel.
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Chapter 6
Working with CB Tabs

More than just a grouping of fields
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What are CB tabs?

A Community Builder tab is something that contains fields and can be positioned in a specific CB
supported spot and also has specific displaying and viewing properties.

Tab Properties

A CB Tab has the following properties:

1. Title (the name you want to give the tab and may be displayed on user profiles if so
configured)

2. Description (an HTML formatted description of this tab that is normally displayed during
profile edit)

Publish (Yes/No status)

Profile Ordering (the ordering of this tab compared to others that occupy the same

position)

5. Registration Ordering (the ordering of this tab's fields that are marked to appear on
registration form)

v 0 N O

Profile Positions

Display Type (how this tab is to be displayed)

Position (where this tab contents are to be shown on a user profile)

Access Level (which Joomla ACL Views can see this tab)
. CSS Class

The default CB Template has a number of predefined positions that a tab can be configured to
appear in. If multiple tabs share the same position then the layout will be adjusted so
accommodate the tab contents.

There are 14 profile Canvas positions available:

1. Canvas
. Canvas
. Canvas
. Canvas
. Canvas

. Canvas

~N o U W N

. Canvas

Menu
Background
Stats Top
Stats Middle
Stats Bottom
Photo

Title Top

8. Canvas Title Middle

9. Canvas Title Bottom

10.
11.
12.
13.
14.

Canvas Main Left

Canvas Main Left Static
Canvas Main Middle
Canvas Main Right

Canvas Main Right Static

Some of these positions have been tagged (with list number) on Figure 40 for your visual

inspection.
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Edit~= Connections = o

® Contact Info Ar@ Blogs )

Formatted admin
Name

Powered by Gommunity Builder

Figure 40: Profile Canvas Position options
There are 6 traditional profile positions:

. Header (above left/middle/right)

. Left side (of middle area)

. Middle area

. Right side (of middle area)

. Main area (below left/middle/right)

oA U W N

. Bottom area (below main area)

The Header position is located above the Canvas Menu position. The Left, Middle, Right follow

below the entire Canvas area and then the Main and Bottom positions.

Memb@e

12 days

Last Online

8 minutes ago

Last Updated
4 days ago

These locations are shown in Figure 41 that is a profile page containing 6 published tabs in these 6

positions.
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Header

f1 -

Edit - Connections =

® Contact Info Blogs@  Articles @ =
Formatted admin hMember Since
Name 13 days
Last Online
about a minute ago
Last Updated
5 days ago
Left Middle Right
f2 - 3 - 4 -
Main below
5 -
Bottom

f6 -

Figure 41: Traditional Profile positions

The profile page also has some new positions after the Bottom traditional position location. There
is a grid set of 9 x 9 = 81 positions named Line 1 Column 1,...,,Line 1 Column 9, ..., Line
9 Column 9.

Finally there is are 9 more position marked as Not displayed on profile 1 through 9.
These positions do not have any physical location and are assigned to tabs that have fields in them
that we do not want to appear in normal profile viewing. Such fields and tabs will appear however
during profile editing.
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Display Type

Another tab property is the Display Type that influences the actual appearance of the tab
contents on a profile page. This property can be set to one of the following values:

1. Tab Horizontal (Left/Right) 8. Div without Title
2. Nested Tab Horizontal 9. Rounded Div with Title
(Left/Right)

10. Rounded Div without Title

3. Tab Vertical (Up/Down) _ .
11. Overlay moving with Mouse
4. Nested Tab Vertical (Up/Down) ) ) )
12. Fixed Overlay closing with
5. Tab Menu Mouseout
6. Nested Tab Menu 13. Button with Fixed Overlay
7.

Div with Title

When you create a new CB tab, its default Display Type is setto Tab Horizontal
(Left/Right). This means that if multiple tabs are set to the same position and have display
type setto Tab Horizontal (Left/Right), then they will be spaced out horizontally from left
to right. If there are more tabs than the template spacing will allow, then the extra tabs will just
overflow below (feel free to experiment and verify this on your own). Such an example is shown in
Figure 42.

1 -
Figure 42: Tab overflow example
To overcome this overflowing issue, you can set these same positioned tabs to a Display Type

of Tab Menu. This will produce an effect shown in Figure 43 where left and right scroll buttons are
provided.
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fé -

< T11 T12 T13 T14 T15 T16 T17 T18 T19 T20 >

Powered by Community Builder

Figure 43: Tabs set for Tab Menu Display Type in position Line 1 Column 1

And as Community Builder is responsive this Tab Menu set will collapse in a narrow browser to an
expandable menu icon as shown in Figure 44.

T18
T19
T20

21

o

Figure 44: Expanded Menu
Icon

Another Display Type Ssetting is the Nested Tab Menu option that is illustrated in Figure 45.
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Figure 45: Nested Tab Menu Example

You can experiment with the rest of the Display Type settings and get a feel of how

Note they influence the way your tabs are displayed on your profile pages.

Tab Access Level Property

For Joomla users this setting should be more or less understood. This property basically lets you
decide which Joomla ACL views can actually see a specific tab. This is one method you can use to
give your users different tabs depending on which Joomla user groups the are part of.

As an exercise, try and create and configure 2 different tabs (and put some fields in
Tip them) and make one tab available to user A (but not to user B) and the second tab
available to user B (but not to user A).

Search Tools and Batch Tools

We haven't really mentioned this yet, but our CB Tab Management page also has 2 very powerful
operational functions that will make your life easier.
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garch Tabs Q Search Tools - Batch Tools - Clear Profile Order ascending H

Search Tools

- Select Published - & | - Select Access - 5 | - Select Position - s | - Select Display Type - E

- Select Plugin -

Batch Tools

a

- Select Display Type - + | -Select Access - + | - Select Position - =

Figure 46: Tab Management Search and Batch Tools

The Search Tools let you filter off the Publication status, the Access view, the Position setting, the
Display type or the Plugin property of tabs.

In a similar fashion the Batch Tools let you perform mass processing on a preselected set of tabs.
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Chapter 7
Working with CB User
Management

Operational matters
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CB User Management Basics

It may look like your Joomla User manager, but it is much more.

Once CB is installed you should stop using the Joomla User Manager and use the CB User
Management page instead.

If you use the Joomla user manager (especially for creating or deleting users), you will risk getting
you database out of sync.

If you make a mistake and add or remove users from the Joomla User Manager, you
Tip should run the Community Builder > Tools » Synchronize Users tool that will
synchronize your Joomla and CB tables in the database.

You should always delete users using the CB User Management page ad this will fire
necessary event triggers for clean-up activities that need to be performed in other
integrated extensions using CB plugins. For example, when a user is deleted using the
CB User Management page, this user's private messages are also deleted from the
uddelM database. Removal of a user from the Joomla User Manager will most likely
result in leaving such entries in the database.

Note

The CB User Management page shown in Figure 47 is accessible from the Community Builder > User
Management menu.

& Community Builder: User Management Joomial
B @ o | = vessveie || B Resec Connmation | X Deles | © Glose © heip || % Permissions
Lol Search Tocls - | Baich Tools ~ REEEY Id ascending
Search Tools
-Gelect Onine - 5 | -SelectGroup - & || - Select Banned - + | - Salect Enabled - & || - Select Confirmed - + | - Salect Approved - &
- Seleet Field - » | -Sekct Operalor - B n
Search
Batch Tools
- Balect Groups - - Select Banned - % | - Select Enabled - & - Select Corfirmed - | - Select Approved - %
Pubiic
| Guast
| Marager
¥ Name  Usemame online Group Emall Reqistered Last Visit Banned Enabled Gonfirmed  Approved i [3
1 Super adin v Super Lsers  nant@jooniapolis.com 0202502015 031142015 ® " v ' 152
Admin &40 10:15:28
Display # 20 ¢ [1f)

Figure 47: CB User Management Page
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Notice the Help button (every CB administrative page has one) in the upper right corner and also the
following action buttons:

New (used to create a new user) 5. Delete (used to delete one or more selected

Edit (used to edit a specific checkbox users)

selected user) 6. Close (closes the CB User Management
page and takes you back to the CB Control

3. Mass Ma}ller (useq to send mass Panel page)
personalized emails to selected users)

. . 7. Search Tools
4. Resend Confirmation (used to resend

pending confirmation emails) 8. Batch Tools

The New, Edit, Delete and Close buttons are self-explanatory and you can explore their functionality on
your own. Let's discuss the other buttons.

Mass Mailer

From your User Management page you can select one or more users by toggling their checkbox in
the first column. You can also use the Search Tools (discussed later on) to filter your displayed
users before selecting the ones you want (again using the checkboxes).

Once you have selected at least one user you can click on the Mass Mailer button and you will see
the Mass Mailer page that lets you configure everything related to the mass email message you
want to send.

You will first be shown a list of the selected users (with their email addresses) that will be emailed.
You can configure the following:

1. Simulation Mode (a checkbox to From Email Address

do a dry-run
Y ) Reply-To Name

6
7
Email Subject .
8. Reply-To Email Address
9

Email Message (HTML supported

editor)

Email Attachments 10. Seconds of pause between
batches

Emails per batch

From Name

Once again, the field tooltips are here to help you understand the meaning of each setting. Once
you have populated the fields you can click on the Send Mails button to start the mailing process or
you can click on the Cancel button to return to the User Management page.

The Subject and Message fields support CB field substitutions so you can personalize
Tip your messages. E.g., Hi [firstname] can be used to setup a personal greeting to each
emailed user.
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Resend Confirmation

If you have configured your CB Registration process to require applicants to verify their emails
before they are activated, then this functionality is useful for you. The Search Tools can be used to
find all Pending confirmation users and you can checkbox select them and then click on the
Resend Confirmation button to send them a reminder email.

The email confirmation workflow for the registration process is activated from the
Note Community Builder > Configuration » Registration tab by setting the Email Confirmation
parameter to Yes.

Search Tools

The Search Tools button when clicked will reveal a set of drop-down filters that can be applied
against your displayed users.

Q Search Tools = Batch Tools = Clear Id ascending B

-Select Online - ¥ || | Super Users % | -SelectBanned- + | - SelectEnabled - ¥ | - Select Confirmed - = | - Select Approved - =

Search Tools

ar

- Select Fleld - - - Select Operator -

Figure 48: User Manager Search Tool Filters

You can also filter on specific combinations of CB Field values. Once you have selected your filters
you can click on the Search button to apply them. If needed, the CB User Management Help button
gives more details on these filters.

The green + button can be used to cascade CB Field based filtering in your Search
Tip Tools area. Such cascading will produce additional (AND) filtering criteria that will be
applied against your results.
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Batch Tools

The Batch Tools functionality lets you perform batch updates on a preselected number of users. It

can be used after Search Tools filtering to perform specific updates on many users in one pass.

Q Search Tools ~ Batch Tools « Clear Id ascending H

- Select Groups - - Selact Bannad - § - Select Enabled - § | - Select Confirmed - § | - Select Approved - 5
Publie

Guest

Manager

Figure 49: User Management Batch Tools options

Batch Tools

As you can see you are able to mass update the following user properties:

Joomla ACL groups
Banned status
Enabled status

Confirmation status

o M w D PE

Approval status
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5 COMMUNITY

Chapter 8
Working with Plugins

Profile applications at work


https://www.joomlapolis.com/community-builder

What is a CB Plugin?

A Community Builder plugin is an application that can operate on CB related pages. CB plugins
should not be confused with Joomla plugins3.

CB Plugins are installed and managed using the Community Builder Plugin Management page
(see the Install CB Plugin button in Figure 50) and not the Joomla Plugin Manager.

ion
Cautio Can't find Joomla XML setup file.

If you try to install a CB plugin using the Joomla Extensions installer you will get an
error stating something like:

If you try to install a Joomla plugin using the CB PLugin Management page you will also
get an error stating:

Could not find a CB XML setup file in the package.

Plugin Types

There are 3 CB plugin types:

Note

1. User

Such a CB plugin will add functionality to one or more CB pages. Such a plugin can also
extend CB by adding a new field type to the CB Field Management page (e.g., the CB
Query field plugin) or a new user profile tabs (e.g., CB Gallery plugin, CB Profilebook
plugin, CB Invites, etc.). User type plugins are further characterized as component plugins.

Template

A plugin that adds a new CB template (or over-rides an existing CB template). Once you
install and publish such a CB template plugin your Configuration Template parameter (see
user profile tab) will have an extra option in the drop-down selector (in addition to the
default one)

Language
CB localization is accomplished with one or more CB Language plugins. Correct, CB does
not use the (we believe slow loading) Joomla ini files.

The CB Plugin code folders are located in your Joomla » components »
com_comprofiler > plugin > (user, language, templates) folder area.

Let's discuss these concepts by looking into specific example plugins that are preinstalled for us
during the CB installation process.

3 The term plugin was actually introduced in Community Builder before the birth of Joomla (after the

Mambo fork) and was selected to distinguish itself from the Mambo term mambot that was used.
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Built-in plugins

Your Community Builder installation has some built-in plugins that you can see by visiting the CB
Plugin Management page.

i Community Builder: Plugin Management

[ Edit + Publish || € Unpublish X Delete | @ Close © Help & Permissions

Q Search Tools = Baich Tools ~ Clear Order ascending H
] Name Version Installed Published Access Level Type Element Order |2 15}
1 Default language (English) 207 v W Fublic language default_languag... 1 13
2 Default 2.0.7 W W Fubiic tempiates default 1 ¥
3 CB Core 2071 v " Public user ch.core o 1 1
4 CB Menu 207 " W Pulbiic usar ch.menu - o 2 14
] GCB Connpctions 207 v W Pubiic usar ch.connections - 3 2
6 CE Anicles 207 ' v Public usar charticles - 8 17
7 Frivate Message System 207 w x Public user PMS.Mypmspro L 8 15
] CE Forums 207 W v Fubiic user chforums - g 18
] CE Blogs 207 v L% Public user chbblegs - 10 19

Blogs

Display # 20 5 [1-8/8)

Figure 50: CB Plugin Management page

A quick visual inspection of our CB Plugin Management page as shown in Figure 50 will reveal that
our default CB installation has: 1 language type plugin, 1 template type plugin and 7 user type
plugins. You will also notice the Blogs button under the CB Blogs listing (in position 9 of the page).
This is an indication that the CB Blogs plugin is a user type component plugin.

A CB user type plugin may also have one or more CB tabs associated with it and even specific CB
fields. Such examples are:

1. CB Core plugin has Canvas, Contact Info, Portrait, Statistics and User Profile Page Title
tabs

CB Menu plugin has User Status and Menu tabs

CB Blogs plugin has Blogs tab

CB Articles plugin has Articles tab

CB Forums plugin has Forums tab

CB Connections plugin has Connections and Connections Paths tabs

N o g bk~ DN

Private Message System plugin has Quick Message tab
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The first 2 plugins in this list are core elements of Community Builder and should not be tampered
with unless you are absolutely sure of what you are doing.

Looking at our CB Plugin Management page you will also see that each plugin has Published
status property and an Access Level status. Some plugins cannot be unpublished (e.g., CB Core,
Default Language, Default template) and some cannot even be deleted.

In most cases you should not change the Access Level status of your plugins and just

Caution keep them at Public (unless you are absolutely sure of implications). For example if you
change the Access Level of your CB Core plugin to Registered you will basically kill your
CB Registration process by not allowing code elements of CB to be accessible to the

public viewers wishing to registered on your website.

In the remainder of this chapter we will be exploring some of the built-in user type plugins that you
can configure and take advantage of on your CB website.

We will be discussing CB Language plugins in a dedicated chapter.

You can study the contents of the default template folder in your Joomla » components
Note » com_comprofiler » plugin > templates > default folder and also the video tutorial #31
of our CB 2.0 tutorials playlist to see how to create a basic template over-ride plugin.
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CB Blogs plugin

The CB Blogs plugin lets you configure a new application for your user profile pages. Your users
will be able to create their own blog elements from their user profiles. The plugin also creates a CB
BLogs tab that should also be published during the configuration process.

You can configure your CB Blogs plugin be clicking on it in your CB Plugin Management page and
accessing its Parameters tab that is shown in Figure 51.

Name | CB Blogs * 0
Global Parameters

General Blogs Defaults

Model Internal = @

Mode Intro & Full| 5

Categories General,Movies,Music,Games,Sports i)

Create Access Registered |+ ©

Create Limit

Captcha Enable Disable [Kil

Li]
Approval Enable i
Auto Delete Disable ©
Figure 51: CB Blogs Parameters

By default the CB Blogs Model setting (check tooltip) is configured to Internal mode and the
Categories field contains a set of comma delimited blog category names that are available to users
to blog under. The Internal mode setting will store user created blogs in an internal to CB storage
area.

There are 2 additional Model options available for selection:

1. Joomla (stores user created blogs as Joomla articles in specific Joomla categories)
2. K2 (stores blogs as K24 articles)

4 Requires the installation and configuration of the K2 extension.
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These 2 models have some advantages over the Internal model. If you store user blogs as Joomla
articles, you can use the built-in Joomla article presentation features to display these user blogs in
dedicated Joomla pages. The same is true for the K2 model as K2 also has similar page layout
possibilities.

When selecting one of the Joomla or K2 Models for your CB Blogs you need to first create a
Categories tree structure that will be used. Let's say you want to allow users to store their blogs in
one of three categories: Personal, Trendy, Miscellaneous. Your Joomla categories tree should look
like:

e User Blogs
o Personal
o Trendy

o Miscellaneous

Then in your CB Blogs » Parameters » Blogs tab you would populate the Categories (drop-
down for Joomla/K2 Models) to User Blogs. This will enable users to select one of the three sub-
categories as their blogging category when they create a new blog.

The rest of the parameters on the Blogs and the Defaults sub-tabs are self-explanatory and have
helpful tooltips to guide you.

If you need extra help you can visit the video tutorials on the Youtube Joomlapolis
Tip channel as it has some very relevant sessions on CB Blogs and the individual Models
configurations.

The Captcha parameter on the Parameters Blogs tab integrates with the CB Antispam

Note plugin that is a paid members download.
Your users can make use of any Joomla HTML editor to create their blogs. You can also
Bonus install and configure the free JCE HTML editor and let users upload images for their
Tip blogs in their own dedicate storage area on your site. There is a video tutorial on the

Joomlapolis Youtube channel that shows you how to do this.

The Parameters General tab has a Template parameter that is set to Default. You can
Developer create your own template for blog pages by studying (cloning) the default one located in
Tip your Joomla » components » com_comprofiler > plugin > user > plug_cbblogs >
templates > default folder.
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CB Articles plugin

The CB Articles plugin integrates with the Joomla Articles component (or the K2 component) and
displays all articles published by an author in an Articles tab (also needs to be published) on the
author's user profile page.

The configuration of this plugin is simple:

1. Go to the Parameters Articles sub-tab by clicking on the CB Articles plugin link on the CB
Plugin Management page

2. Set the Model parameter to either Joomla or K2 (depending on which content you want to
show and if you have K2 installed of course)

3. Select which Joomla/K2 categories are to be exempt by selecting them in the Exclude
Categories parameter.

If you leave the Model setting to its default Auto Detect setting then all content from all Joomla
categories will be used.

The Articles plugin does not provide the means to initiate the creation of new articles
Note from your CB profile page. You would need to use Joomla or K2 links to create such
content items that the Articles plugin will then pick-up for display purposes only.

Ti If you need extra help you can visit the video tutorials on the Youtube Joomlapolis
Ip channel as it has some very relevant sessions on CB Articles.

The Parameters General tab has a Template parameter that is set to Default. You can
Developer create your own template for blog pages by studying (cloning) the default one located in
Tip your Joomla » components » com_comprofiler > plugin » user > plug_cbarticles >
templates > default folder.
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CB Forums plugin

The CB Forums plugin (and relevant tab) are used to integrate Community Builder with the Kunena
Forum extension (must be downloaded from the Kunena site and installed) for Joomla.

Once you have installed and configured Kunena for Community Builder integration (basically
publish the Kunena — Community Builder Integration plugin from the Kunena Plug-in Manager
page) you can publish and configure the CB Forums tab and the CB Forums plugin parameters.

The CB Forums tab is not published by default, so you should not forget to publish it. The actual
tab parameters has three sub-tabs that you can configure:

1. Posts sub-tab
2. Favorites sub-tab

3. Subscriptions sub-tab

The default parameters on these sub-tabs will work just fine, but feel free to take a closer look at all
the parameters and read their tooltips if the labels are not self-explanatory.

There are also some parameters that you can configure in the CB Forums plugin area that
basically map CB fields to Kunena ones. This way users profile data can be used to influence
various Kunena forum user values.

To see these extra parameters toy need to first specify the Kunena version in the Model parameter
drop-down option and set it from its Auto Detect setting to one of the values:

1. Kunena 2.Xx

2. Kunena 3.Xx

depending on the version of Kunena you have installed.

Once the Kunena version is selected you will see 2 new sub-tabs appear that are named: Profile
and Sidebar.

The Profile sub-tab parameters are:

1. Ordering 7. Location
2. Viewtype 8. ICQ

3. Signature 9. AIM

4. Personal Text 10.YIM

5. Gender 11.MSN

6. Birthdate 12.Skype
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13.Twitter 20.Digg

14 .Facebook 21.BlogSpot
15.Gtalk 22.Flicker

16 .MySpace 23.Bebo

17 .LinkedIn 24 .Website
18.Delicious 25.Hide Email
19.FriendFeed 26.Show Online

Each parameter can mapped to a CB field. For example the Gender parameter can be mapped to
a CB Radio type field that accepts the values 1=Male, 2=Female and 0=Unknown. These values
are given in the tooltip popup helper of the Gender parameter. Similar tips are given in the other
parameters.

You might notice that you cannot map the following Kunena field entities:

Posts
Karma
Rank
Thank You

P o N PR

In order to be able to display these values in user profile pages (or even CB User lists), you need to
create new CB Fields of type Forum Status and configure the Status drop-down parameter setting
(located in the field Parameters » Display sub-tab) appropriately.

If you need extra help you can visit the video tutorials on the Youtube Joomlapolis

Tip channel as it has some very relevant sessions on CB Forums configuration and settings.
Create a cb_gender radio button field and sync it with the Kunena Gender field in your
CB Plugin Management » CB Forums » Parameters » Forums > Profile tab. Then

Exer_mse create 4 Forum Status type fields cb_posts, cb_rank and cb_karma. You can then
Tip display these Kunena calculated fields on your user profile pages. This exercise will help
you understand the Sidebar sub-tab usage discussion that follows.

There is also a Sidebar sub-tab that lets you add HTML code to replace the Kunena Forum sidebar
default display. There are three text-area parameters for code for sidebar display shown to:

1. Registered (posters that are registered on the site)
2. Anonymous (anonymous posters)
3. Deleted (posts belonging to deleted users)
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By default a Kunena forum sidebar looks like the one shown in Figure 52.

® Hi my name is Fenia 1 day 23 hours ago

fenia My username is fenia.

m My gender is female.

New Member
[
Posts: 1
Karma: 1 == ==
&
Last Edit: 1 minute ago by admin. Report to moderator IP: 1
® My username is admin 1 day 5 hours ago
admin My username is admin
My gender is Uknown
[ NOW ONLINE |
Administrator
200000
Posts: 2
Karma: 0
-

Last Edit: 1 minute ago by admin. Report to moderator IP: 1

Figure 52: Default Kunena forum sidebar

With the Sidebar sub-tab parameters we can take over the display of the forum sidebar and adjust
it as we see fit. Some CSS, HTML and CB field substitution knowledge is needed to really take
advantage of this feature.

To get you started here is a sample that basically replicates the default Kunena view and adds an
extra VIP tag at the end (after the gender icon) for posters that have their cb_vip checkbox field
(you need to create this in CB Field Management page) checked (means set to 1).

Figure 53, Figure 54 and Figure 55 give you code snippets for sidebar configuration of forum posts
made by Registered, Deleted and Guest posters. If you have configured the fields according to the
previous Exercise Tip project you should be able to just copy and paste the code from the 3 figures
into the three parameter text areas of the sidebar sub-tab.
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<ul class="kpost-profile">
<1li class="kpost-username">
<a class="kwho-user"
href="index.php?option=com comprofiler&task=userProfile&user=[user_ id]"
title="View [username]'s Profile" rel="nofollow">[username]</a>
</1li>
<li class="kpost-avatar">
<span class="kavatar">
<a class="kwho-user"
href="index.php?option=com comprofiler&task=userProfile&user=[user_ id]"
title="View [username]'s Profile"
rel="nofollow">
<img class="kavatar"
src="[cb:userdata field="avatar" reason="list" /]"
alt="[username]'s Avatar"
style="max-width: 144px; max-height: 144px" />

</a>
</span>
</1li>
[cb:if onlinestatus="true"]
<li>
<span class="kicon-button kbuttononline-yes">
<span class="online-yes">
<span>NOW ONLINE</span>
</span>
</span>
</1li>
[/cb:if]
[cb:if onlinestatus="false"]
<li>
<span class="kicon-button kbuttononline-no">
<span class="online-no">
<span>OFFLINE</span>
</span>
</span>
</1li>
[/cb:if]

<li class="kpost-userrank">
[cb:userfield field="cb_rank"/]
</1li>
<li class="kpost-userposts">
Posts: [cb:userfield field="cb_posts"/]
</1li>
<li class="kpost-karma">
Karma: [cb:userfield field="cb_karma"/] [karmaminus] [karmaplus]
</1li>
[cb:if cb_gender="0"]
<1li class="kpost-smallicons">
<span class="kicon-profile kicon-profile-gender-unknown"
title="Gender: Unknown">
</span>
</1li>
[/cb:if]
[cb:if cb_gender="1"]
<li class="kpost-smallicons">
<span class="kicon-profile kicon-profile-gender-male"
title="Gender: Male">
</span>
</1li>
[/cb:if]
[cb:if cb_gender="2"]
<li class="kpost-smallicons">
<span class="kicon-profile kicon-profile-gender-female"
title="Gender: Female">

</span>
</1li>
[/cb:if]
[cb:if cb_vip="1"]
<li>
<span class="kicon-button kbuttononline-yes">
<span class="online-yes">
<span>VIP</span>
</span>
</span>
</1li>
[/cb:if]

</ul>

Figure 53: Sidebar code for Registered forum posters
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<ul class="kpost-profile">
<1li class="kpost-username">DELETED</1li>
</ul>

Figure 54: Sidebar code for deleted forum posters

<ul class="kpost-profile">
<li class="kpost-username">GUEST</1li>
</ul>

Figure 55: Sidebar code for guest posters

And in Figure 56 you see the results where the default Kunena sidebar view is replicated with the
addition of a VIP tag that follows the gender icon (if the poster's cb_vip checkbox field is ticked),

® Hi my name is Fenia 2 days 6 minutes ago

fenia My username is fenia.
m My gender is fernale.
New Member
=
Posts: 1
Karma: 1 == <
o
Last Edit: 15 minutes ago by admin. Repart to moderator IP: 1

® My username is admin 1 day 5 hours ago

admin My username is admin
My gender is Uknown

Administrator

9900000
Posts: 2
Karma: 0

- Last Edit: 14 minutes ago by admin. Repart to moderator IP: 1

Figure 56: Forum sidebar replicated with new VIP feature

If you are working on a multi-language website you will want to create 3 new language
Tip strings in your language plugins and localize the three sidebar code snippets. More
about language strings later on in this book.
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Private Message System plugin

This plugin is used to integrate Community Builder with the uddelM (must be downloaded from the
uddelM site and installed) private message extension for Joomla.

Once you have installed and configured uddelM for Community Builder integration (basically locate
the Use profile links and Show thumbnails parameters on the Integrations tab of uddelM and set
them to Community Builder and set the A1l1low BB code tags on the Messages tab to Yes) you
can publish and configure the Quick Message tab and the Private Message System plugin
parameters.

There are also 2 more Community Builder related settings that you should look at:

1. Community Builder » Connections tab » Notification Method parameter that you can
configure for PMS or PMS and Email

2. CB Login module > Logout Options » Private Message Notifications and
Private Message Icon parameters

If you need extra help you can visit the video tutorials on the Youtube Joomlapolis

Tip channel as it has some very relevant sessions on uddelM configuration and settings.
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Chapter 9
Working with Connections

People relations on your site


https://www.joomlapolis.com/community-builder

What's a Connection?

The Connections functionality lets your users form relationships with each other. On many public
social networking sites this relationship uses the term friend request. Community Builder uses the
term connection request.

Configuration Steps

The Connections feature is by default enabled when you install Community Builder for the first
time. You can verify the configuration settings by inspecting:

1. Community Builder > Configuration > Connections tab
2. Community Builder > Plugin Management » CB Connections plugin

3. Community Builder » Tab Management » Connections and Connection Paths tabs

Configuration Connections tab

There are a number of parameter settings located on the Connections tab on your CB
Configuration page.

General Registration User Profile Images Maoderation Connections Integrations
Enable Connections ACE Mo | ©
Display Type Public '+ ©
Display Connection Path Yas No ©
Mutual Consent ACE Mo | ©
Metification Method None i
Cross Connections Yes No €
Connection Types Friend
Co Worker
Family o

Figure 57: Connections tab configuration

Most of the parameter names are self-explanatory and the tooltips will prove useful if something is
not clear.
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However, here are some concepts that will help you:

1. The Display Type is used to specify if Connections tab is viewable on other user
profiles

2. The DIsplay Connection Path will show you how you are connected to the owner of
the user profile you are visiting. The Connection Path tab also needs to be published for
this setting to work.

3. Mutual Consent means that a connection is only established when both ends agree.
This means someone must request and the requester must accept.

4. Notification Method lets you establish how users will be notified of new connection
requests and connection acceptance events.

5. Connections can be bidirectional or unidirectional. By default Cross Connections are
setto Yes.

6. Connections Types are used as tags to characterize a connection.

CB Connections plugin

The CB Connections plugin has no parameters to configure, but it needs to be published.

Connections and Connection Paths tabs

The Connections tab has the following available settings in its Parameters tab:

Show Summary (Yes/No)
Entries shown in Summary (default 4)

Enable Paging (Yes/No)

0w NP

Max entries shown or per page (default 10)

These parameters are self-explanatory and the tooltips are there if something is not that clear.

The Connection Paths tab has no parameters but it still needs to be published if you want the
connection path to be displayed when visiting other profiles.

In Figure 58 you can see the Connections tab on a user profile page. If you hover your mouse over
a connection image you will see a popup containing relevant data of the connection.

You will also notice that you can visit a connection's profile page by clicking on the image and you
can also send an email or a private message to your connection by clicking on the envelope or
chat icons.

Finally, you can also quickly drop a connection by clicking on the X icon above the connection's
name.
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Edit = Connections «

L. =
] s
. 1
FH
S ana

<| Contactinfo  Articles @ Blogs@®@  Forums > =

® ®

Q Fenia A. Q Antonis A.

a=e a=e
Connection Details

Powe Connected Since 14/11/2014
Types: Friend, Co Worker, Private
Comment: Good friend and excellent

You are here: Home » CB Profile » Super Adm : i
Community Builder user.

Figure 58: Connections tab on user profile page

Managing Connections

To reach the Manage Connections page you select the relevant menu item from your Connections
menu on your CB profile page. This will bring you to the management page that is shown in Figure
59.

On this page you will see 2 tabs:

1. the Manage Actions tab where you can accept or reject any new connection requests

2. the Manage Connections tab where you can edit connection types and comments
pertaining to your existing connections

Ti To select more than one connection type you need to press your Control/Command key
1p while you click on the different types.
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Manage Connections

Manage Actions () Manage Connections

Below you see users to whom you are connected directly.

Connections Type Comment
OFenia A.
Friend
Co Worker
Family
Private
A
aEe
QO Antonis A.

Good friend and excellent

Friend Community Builder user.

Co Worker
Family
Private

Figure 59: Manage Connections page

If you need extra help you can visit the video tutorials on the Youtube Joomlapolis
Tip channel as it has some very relevant sessions on CB Connections configuration and
usage.

At the moment Connections are just an easy way to quickly contact and communicate
with your relevant connected users. There are other add-ons that build upon the
connections and offer more functionality. E.g., the CB Privacy plugin (paid membership)
lets you configure CB fields or entire CB tabs to be accessible only by specific
Connection Types.
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Chapter 10
Language plugins

CB can speak your language


https://www.joomlapolis.com/community-builder

Introduction to CB Language plugins

Community Builder labels, tooltips, descriptions, field names and more or less everything you see
in frontend or administrative (backend) pages can be customized or translated.

This is accomplished with the use of language stings that are stored in CB Language plugins. For
various reasons> Community Builder does not use the INI files method that Joomla uses.

Community Builder has its own built-in default_language plugin (pre-installed in CB Plugin
Management page that cannot be deleted) with translated language strings that fall back to a
default English language interpretation. So if something is missing in your language plugin you will
see the default language (English) content instead of a cryptic language string key.

In fact every Community Builder add-on you install as a CB plugin has its own default_language
folder with default language string files (one for frontend and one for backend).

The default_language folders should never be tampered with as they are part of the core code and
will be overwritten when you upgrade the relevant (CB or CB plugin) package in the future.

What does a CB Language plugin look like?

A CB Language plugin is comprised of a specific set of files. To explore this further let's take a look
at the CB English (en-GB) Language plugin that contains:

en-GB.xml (manifest xml file)

admin_ language.php (backend translation strings in PHP array format)
language.php (frontend translation strings)

index.html (dummy file to prevent direct folder parsing)

a kw0 Dbdh e

cbplugin folder (containing frontend and backend translation files for extra CB plugin add-
ons)

You can grab the latest CB English Language plugin from the Joomlapolis Language resources
page listings at the URL:

https://www.joomlapolis.com/cb-solutions/languages

Just download it and unzip it locally to explore its contents. You can view (or edit) any file by
opening it in your favorite text editor.

5 Mainly performance related
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How to find your CB Language plugin

The Joomlapolis language resources page (URL given previously) contains links to download the
most complete (>70% translated) language plugin packages.

The language plugin packages naming convention follows this example:

plug language dutch nl-NL 2.0.7.1.0.1+635522d67.zip

As you can see the package name contains:

1. the prefix plug language to denote the fact that this is a CB Language PLugin that
needs to be installed using the CB Plugin Management page installer

the name of the language (e.g., dutch)

the locale code of the language (e.g., nl-NL)

the CB version number this plugin is for (e.g., 2.0.7)
the version number of the plugin (e.g., 1.0.1)

o gk~ w N

the hash code of the packages

Installing a CB Language plugin

Once you have located and downloaded your CB Language plugin, you install it just like any other
CB Plugin using the CB Plugin Management page installer.

If the CB version of the language plugin is newer than the CB version you have installed you will
get a failed to install message. In this case you should upgrade your CB installation to the latest
CB release (preferred) or find an earlier version of the relevant language plugin.

Upon successful installation of a Joomlapolis downloaded CB Language plugin you will see a
successful installation message along with a very detailed language contents description. The
same details can be seen by visiting your CB Plugin Management page and finding the language
plugin you just installed (should be the one named as the locale code of the language you
installed, e.g., en-GB).

In Figure 60 you can see what the CB Plugin Management page looks like with various installed
language plugins. As you can see the Default Language (English) is the preinstalled fall-back
plugin we mentioned earlier and the other installed language plugins are named: de_DE, el-GR,
en-GB, fr-FR, nl-NL and ru-RU.
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Q Search Tools « Batch Tools = Claar Ovder ascending

- Salect Published - § - Select Access - * | language

Search Tools

# HName Version Installed Published Access Level Type Element Order |} Q [[#]
1 Default language (English) 207 v v Public: language default_languag... L 1 13
2 de-DE 207101 ' v Public: language de-DE - _ a9 42
3 e-GR 2.0.7.1.01 LY L Pulblic: language el-GR - 99 51
4 an-GB 2.0.7.1.0.1 ' W Pulblic: language en-GB - o a9 B0
5 tr-FR 2.0.7.1.01 v ' Pubilic language fr-FR - _ a9 61
B n-NL 2.0.7.1.01 W L Public: language ni-ML - ) 63
T ru-AU 2.0.7.1.01 L4 L4 Pullic larguage ru-RU - g9 62

Figure 60: CB Language plugins listed in Plugin Management page

Let's inspect the nl-NL (Dutch language) plugin by clicking on its name in the CB Plugin
Management page. You will see the Translation Credits paragraph and the Completion level
section that contains a very detailed table as shown in Figure 61.
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Project |Flesuume ‘Completeness
Communtty Bulkder admin_language.php 100%
language.php 100%
CE Activity cbactivity-language.php 0%
CB Antispam cbant?spam-admm_languaga.php 0%
cbantispam-language.php 0%
CB Auto Actions cbautoact?ons-admm_language.php 7%
cbautoactions-language.php 25%
CB Auto Welcome cb.autowelcome-admin_language.php 0%
cb.autowelcome-language.php 0%
CE Conditional cbconditional-language.php 0%
CB Connect cbconnect-admin_language.php 95%
cbconnect-language.php 4%
CB Core Fields Ajax cbcorefieldsajax-language.php 100%
CB Gallery cbgallery-admin_language.php 0%
cbgallery-language.php 0%
CB Google Translate cbgoogletranslate-admin_language.php 100%
ecbgoogletranslate-language.php 100%
CB Gravatar Field cbgravatarfield-language.php 100%
CB Invites cbfnv?tas-admm_languaga.php 100%
cbinvites-language.php 100%
OB Lastviews Tab cb.Iastv!ews-adm|n_|anguage.php 0%
cb.lastviews-language.php 0%
CB Privacy cbpr?vacy-admin_languaga.php 100%
cbprivacy-language.php 23%
CB Profile Book cb.proﬂlebook-admm_language.php 0%
cb.profilebook-language.php 0%
CB Profile Update Logger cb.pulog-language.php 21%
CE Progress Field cbprogressfield-language.php 100%
CB Query Field cbqueryﬂald-admn_Ianguage.php 100%
cbqueryfield-language.php 92%
CB Reconfirm Email cbreconﬂrmema?l-admm_languaga.php 100%
cbreconfirmemail-language.php 100%
CB Template Changer cbtemplatechanger-language.php 100%

Figure 61: Language Completion statistics

Each translation resource is listed along with its completion percentage status. As you can see

there are some add-on projects that are totally missing (e.g., CB Profile Book, CB Gallery, etc.) and

many that are in progress but incomplete (e.g., CB Profile Update Logger, CB Connect, CB

Privacy, etc.).
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Helping with CB Language Translations

You are encouraged to sign-up on the Transifex site ( https://www.transifex.com ) and join a
translation team to assist with the completion of the translation. You can just click on the left
column project listing and be taken directly to the relevant project on Transifex and once there just
select the language you want and request to join.

You can also join a 100% ready project and propose improvements. If your language is not present
at all on Transifex you can create it and once approved (by the Joomlapolis team) you can start
translating on the very friendly Transifex environment.

Joomlapolis periodically (at least once a week) scans the Transifex projects for updated
translations and pushes new releases to its Languages resources page. However it only does this
for projects that have the main Community Builder resources translated to at least a 70%
completion level.

If you are a loner and want to do this on your own and not share :-(, then you can follow the
instructions given in the CB Language FAQ article that is referenced on the Joomlapolis Language
resources page.

Language Overrides

Currently there is no user interface in Community Builder to manage language string overrides (like
Joomla has). This is planned for the next point release (CB 2.1).

Until that time you can use the CB Language override plugin method as described in the:

CB 2.0 Tutorials - 36 - CB Language Override plugin and how to use it

and the supported forum post here:

http://www.joomlapolis.com/forum/6-news-and-publicity/227556-cb-language-override-video-
tutorial-resources

If you want to change the Join Us! Message on your registration form (see Figure 3), you
need to find and change the relevant language string in your CB language plugin
Tip language.php file. The string you need to find and change looks like:

'REGISTER_TITLE" => 'Join us!’',
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5 COMMUNITY

Chapter 11
Configuration Elements

Yup, we have them


https://www.joomlapolis.com/community-builder

Why now?

As you can see this chapter discussing the Community Builder Configuration page is purposely
placed at almost the very end of this Primer Book.

The intention has been to gradually introduce various configuration elements and implications
throughout other discussions on a need to know basis. It's much easier to understand this way and
hopefully reading this book was an enjoyable experience.

Configuration Tabs

The Community Builder Configuration page can be reached using the CB menu (you know this by
now). Once on this page you will see, as shown in Figure 62, the following 7 tabs:

General
Registration
User Profile
Images
Moderation
Connections

N o g bk~ w NP

Integrations

£ Community Builder: Configuration * Joomlal

& Save © Cancal ©® Help || © Permissions

Your version is 2.07

Latest version 2.0.7

General Registration User Profile Images Maoderation Connections Integrations

Figure 62: CB Configuration page tabs

Many of the parameters on these tabs have been mentioned in previous chapters of this book. We
will not be giving detailed explanations about each parameter as you can access the relevant
tooltip to learn more. The actual parameter labels will be listed so your can get a feeling of what is
available and get perhaps motivate to explore something in more depth.
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General Configuration

This tab has the following parameters:

1. Name Style 8. Emails Sent From
2. Name Format 9. Email Links

3. Date Format 10. Wwebsite Links

4. Time Format 11. Online Status

5. Calendar Type 12. Field Icons

6. Email Handling 13. Login Method

7. Public Email Form

As you can see from the parameter labels this tab is used to set some general guidelines for
various CB elements that will be used in many different CB pages.

Each parameter has its tooltip, so if something above triggers your imagination and you want to
further explore its purpose you know where to start.

Registration Configuration
The Registration tab has the following parameters:

1. Allow User Registration 11. Pending Email Subject

2. Generate Registration Passwords 12. Pending Email Body

3. Admin Approval 13. Welcome Email Subject

4. Email Confirmation 14. Wwelcome Email Body

5. Ajax Username Checker 15. Registration Layout

6. Login on Registration 16. Registration Icon Layout
7. Registration Email Name 17. Registration Title Image
8. Registration Email Address 18. Registration Header

9. Registration Reply-To Email 19. Registration Footer

Address

20. First Login Redirect
10. Registration Email HTML

Once again most of these parameters are self-explanatory and their tooltips will also help clarify
when needed.

Here is a list of important implications and concepts that will steer you in the right direction:

1. TheAllow User Registration setting needs to be configured in parallel with the
Joomla » Users » User Manager » Options » Allow User Registration parameter.
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The Generate Registration Passwords setting is useful when creating users from
CB User Management page and also when registration Password field is empty or not even
shown6 on the CB Registration page.

The Admin Approval and Email Confirmation parameters control the frontend user
registration workflow process.

The Email Subject and Body fields are configured to CB Language plugin strings. You
can configure them directly in their parameter areas but this will kill the ability to send
language specific messages on multi-language sites. They should be kept intact and
translated/modified appropriately in the relevant CB Language plugin files.

The Registration Layout parameter is used to produce registration forms like the
ones shown in Figure 3, Figure 4 and Figure 5.

The Registration Title Image field takes its options from the Joomla Root >
components » com_comprofiler > plugin > templates > default > images > title folder and
the Joomla Root » images folder.

The First Login Redirect parameter has a default value of:
index.php?option=com_comprofiler&view=userprofile
that will redirect user to the CB User Profile page.

The Registration Title Image parameter lets you change the splash image of

Tip your registration form (see Figure 3). You would need to first upload your new image to

your website Joomla Root » images folder.

User Profile Configuration

The User Profile configuration tab has the parameters:

©

Username Edit * Right
Username Fallback 10. 3 Column Layout
Fields Validation in User o Left
Management
. . * Middle
Profile View Access Level
* Right

Maximum Emails per Hour

Maximum Hits Interval in 11. ShowSFmptySTabs

Minutes 12. Show Empty Fields
Template 13. Empty Field Text
Template Output 14.Allow CMS User Parameters
2 Column Layout 15. Profile Edit Layout

e Left 16. Profile Edit Icon Legend

17. Exclude Tags from Filtering

6 The Password field is also managed in the CB Field Management page and can be configured to not
appear during registration.
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This list is worth reading to understand some implications:

1. Username Fallback is useful is you want to hide the username field from the registration
and login processes.

2. Profile View Access Level is useful if you want your profiles to be available only to
specific view levels. E.g., you can set this to Public and set the tab view levels to registered
for the tabs you do not want public.

3. Allow CMS User Parameters lets you show Joomla CMS parameters on your user
profiles. Take a look at the params field in your CB Field Management page for more info.

4. Exclude Tags from Filtering lets you configure which HTML tags should not be
stripped out when saving editor fields.

Images

The Images tab has the following configuration parameters:

P NP

Image Software 5. Default Maximum Image Filesize
Always Resample Image Uploads 6. Default Maximum Thumbnail
Height

Default Maximum Image Height

. . Default Maximum Thumbnail Width
Default Maximum Image Width

Maintain Aspect Ratio

Most of these parameters have been explored in Chapter 4.

Here is a list of important implications regarding some of these parameters:

1.

The Image Software parameter automatically detects which image libraries are available
on your server. In most cases this parameter will be automatically set to GD2 (represents
the PHP GD library). Some servers may also have the ImageMagick® library

( http://www.imagemagick.org/ ).

Keeping the Always Resample Image Uploads setting to Yes is a good security
measure as resampling will help cleanup any malicious code that might have infected the
image file.

Moderation Configuration

The Moderation tab parameters are:

A 0N PE

Moderators View Access Level 5. Require Upload Image Approval

Moderator Approve Users 6. Allow Moderators to Edit User

. Profiles
Send Moderator Email

7. Allow Profile Banning
Allow User Reports

Chapter 11 Configuration Elements 105


http://www.imagemagick.org/

Here is a list of items that you should keep in mind:

1. To take advantage of the Moderators View Access Level functionality you need to
understand how the Joomla ACL Views work and how they differ from Joomla groups.

2. Moderator Approve Users should be left to Yes if you want to enable front-end
approval of new registration applicants (if the CB Configuration > Registration tab » Admin
Approval parameter is also set to Yes).

3. Send Moderator Email setto Yes will email all users in the Moderators View
Access level to notify them of pending approval actions. You can turn on/off this
notification for a specific use from the CB User Management > Contact Info » Receive
Moderator Emails checkbox.

4. Allow User Reports andAllow Profile Banning let users report other users (for
bad behavior) and allow moderators to manage these reports (via CB Workflows module)
and also ban/unban specific user profiles.

5. Require Upload Image Approval is the default setting for all images. It can be
overridden in each CB image type field (see relevant book chapter on images).

Connections Configuration

The Connections parameters have already been described and discussed in Chapter 9.

Integrations Configuration
The Integrations tab parameters are:
Translations Highlighting Fontawesome
Spoof Checking jQuery

Version Checking jQuery Migrate

P wonPE
© N o u

Twitter Bootstrap Footer

These parameters should not really be tampered with (except maybe the last one) unless you are
very confident with what they imply.

The spoof Checking parameter can be turned off in cases where you have some third-party
extension that is causing login issues or cookie errors.
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Chapter 12

Conclusions
That's all folks!


https://www.joomlapolis.com/community-builder

Thank you for reading

The authors hope this reading journey was an enjoyable learning experience for you. We are
always open to any suggestions for improvements or needed corrections you noticed in this book.
Just drop us an email at documentation@joomlapolis.com and we will take it from there.

As stated throughout this book, our intention is not to provide a reference manual nor a user's
guide. Instead we took the Primer approach that motivates and helps you help yourself taking
advantage of the many available resources that exist within Community Builder itself and also on
the Joomlapolis website.

If this approach was successful you now understand that Community Builder is an extremely
powerful and flexible tool that can be cleanly (no hacks) out-of-the-box manipulated to satisfy
hundreds of use cases. Plus, it can be extended by installing more CB plugins that are available for
paid members on Joomlapolis or by other third-party developers elsewhere.

Community Builder currently has 41 language project on Transifex with over 300 translators
helping out.

From a technical perspective, Community Builder is built over a ground-breaking and innovative
XML MVS AhaWow engine technology that helps us produce extremely stable and secure results.

The CB community is very large (over 500,000 registered users on Joomlapolis) and the actual
software is powering millions of websites worldwide. CB has been around for over 10 years and its
future is even brighter than ever.

Once again — we thank you for reading and supporting this free GPL project.

g CBlecam =ife g CBlecam e g CBleam s

Nick. A

Figure 63: CB Team members
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Appendix A
More Resources and help

How and where to look for and get more


https://www.joomlapolis.com/community-builder

Resource List

This CB Primer book makes reference to many online resources that are freely available to assist
you. You can also become a paid member and get more add-ons and also support forum posting
privileges where CB Team members are available to help you.

Once again here is a list of free resources you can search and study:

This book and its future updates

2. Getting started articles
www.joomlapolis.com/documentation/community-builder/getting-started

Help button on each CB Administrative page
Tooltip on each parameter

FAQ articles
www.joomlapolis.com/support/faq

6. Tutorial articles
www.joomlapolis.com/support/tutorials

7. Youtube Joomlapolis channel videos
www.youtube.com/Joomlapolis

1. CB 2.0 Tutorials playlist
www.youtube.com/playlist?list=PLpOpuRITgC7PuyzPsMUECDI46VE7IFSAX

2. GroupJive 3.0 Tutorials playlist
www.youtube.com/playlist?list=PLpOpuRITgC7NglIEH-tkUHQc7rRqDw-Pn

3. CB Auto Actions playlist
www.youtube.com/playlist?list=PLpOpuRITgC7McQcw0Sli1qfSUQGwmflzi

4. CB Query playlist
www.youtube.com/playlist?list=PLpOpuRITgC7MM9iP9FooKB1gk8f5MLWVp

5. CB Privacy playlist
www.youtube.com/playlist?list=PLpOpuRITgC7PyiMVKzL-3WKX9Z1iNlyah

6. CB Activity playlist
www.youtube.com/playlist?list=PLpOpuRITgC7Nd1zDCB-fJFvR10H5mTgEF

7. CB Conditional playlist
www.youtube.com/playlist?list=PLpOpuRITgC7PxD6MvmDwWNNIi2ZHNcYxs7u

8. Joomlapolis forums

1. Community Support forums
www.joomlapolis.com/forum/145-community-builder

2. Potential Bug reporting forum (must read-before-posting!)
www.joomlapolis.com/forum/147-potential-bug

3. Language forums
www.joomlapolis.com/forum/162-languages

4. Professional Support forum
www.joomlapolis.com/forum/153-professional-member-support

5. Developer support forum
www.joomlapolis.com/forum/255-developer-members-support
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6. CBSubs GPL support forum
www.joomlapolis.com/forum/277-cbsubs-gpl-support

7. Templates support forum
www.joomlapolis.com/forum/template-support

9. Google search

If you cannot find the answer to your question and you have searched thoroughly, then you can
post on the free community driven forums where other community members may offer to assist
you.

If you want assistance from CB Team members then you should consider becoming a paid
member in order to post on the Professional Support forums and get more add-ons also in the
process.

Guidelines for Posting on Any Forum

One of our FAQ articles that you should read and follow before posting on the forums is the Help
Us Help You FAQ article:

www.joomlapolis.com/support/fag/101-support/18234-help-us-help-you

Reporting Potential Bugs

There is a specific free forum area where you can report a potential bug you think you found.
Before posting you should first follow the Help Us Help You article as it might resolve your issue.

If your issue is not resolved then post on the Potential Bug forum:
www.joomlapolis.com/forum/147-potential-bug
When you post here you should follow the Read before posting guidelines of the forum area:
www.joomlapolis.com/forum/147-potential-bug/226964-read-before-posting

If you post without following these guidelines your post will be moved to some other free forum and
your karma might also be decreased for not following the process.

If your post has included all the information requested by the Read before posting article then a CB
Team member will respond to your post with resolution or action taken.

Posting on the Language Forums

If English is not your native language then you may find someone to help you on the various
Language forums:

www.joomlapolis.com/forum/162-languages
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Posting on the Paid Forums

The Developer and Professional support forums are write restricted for paid users only. However,
anyone can read the threads and the discussions and learn — true open-source spirit.

If you are such a paid member you can start your own support thread if you followed the previously
stated guidelines without reaching a resolution to your issue. When posting once again please
follow that posting guidelines and in particular:

1. Always give exact versions of your Joomla, CB, etc. environment. Statements like: | have
the latest of everything are not really helpful.

2. Provide a descriptive subject that helps everyone understand the issue. Subjects like:
Please Help or Doesn't Work or It broke my site are not helpful.

3. When describing your issue be as clear as possible. Try and use CB terms and not your
own. Give details and even screenshots of configurations if needed and results you are
seeing. The clearer your post is the quicker your issue will be resolved. Try not to make
people think to understand what you are writing — let them focus their thought on helping
you resolve your issue.

4. Be polite and courteous and also give a thank you to people who respond to help you.

Understand that sometimes the answer might be “No” and that some requests might be our
of scope of the support forums. E.g., “Can you help me code this” or “Can you give me
CSS code that does this”, etc.

Paid Add-ons

The Professional add-ons that are described on this page:

www.joomlapolis.com/ch-solutions/add-ons

are available to all Professional and Developer members.
The list is continuously growing as new add-ons are released very often.

If you wish to start offering paid subscription memberships on your CB website you should look into
the CBSubs GPL solution as described here:

www.joomlapolis.com/ch-solutions/cbsubs

CBSubs is not included in the Professional membership level and must be purchased in parallel.
CBSubs is included in the Developer membership level.

Joomlapolis also has 4 very slick and light-weight Joomla Templates that fully support all CB
pages. These GPL templates can be purchased separately or in bundles as described here:

www.joomlapolis.com/joomla-templates

All 4 templates are included in the Developer membership level which basically gives you access
to everything Joomlapolis offers.
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The rest of this Appendix has some teaser images regarding some of the 23 extra add-ons
available for Download on Joomlapolis if you become a Professional member.
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CB GroupJive package

The CB GroupJive package is available to Professional and Developer subscribers. It empowers
your users to create their own mini-communities with wall and media sharing, events and
invitations, and private forum discussions with it's built-in Kunena forum integration.

CB GroupJive

& " o
I Community Builder Add-ons @ Open & 3 Users

[5al 2 Photos [ 2 Videos [ 2 Files & 2 Discussions

£33 Events o
< Wall Photos Videos Files Forums Events Users >
© Mew Event Q. | Search Events.

O

CB GroupJive 3.0.1 Released

This event has ended.
@ Wednesday, December 16 2015 12:00 AM - Thursday, December 17 2015 12:00 AM

9 Joomlapolis Download Area

& 0 Guests Super Admin

Release 3.0.1 is now available for download by all Professional+ members. We
have also released a cool CB Group.Jive Primer Book to help you get started.

Figure 64: GroupJive Group page example

You can learn more about GroupJive by downloading the free GroupJive Primer Book
from the following link (you need to be logged in on Joomlapolis to access):
www.joomlapolis.com/component/docman/doc_details/792-groupjive-primer-book
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CB Gallery plugin

The CB Gallery plugin is one of the paid add-ons available to Professional and Developer
members. It adds multi-media galleries to your user profile pages. You can learn more about this
add-on by reading its release announcement on Joomlapolis:

www.joomlapolis.com/news/18487-new-cb-gallery-supports-photos-files-videos-and-music

Fa,mlly admin =
February 24, 2015

Family Photos from various events

Q, | Search Phatos...

Both daughters My iiztie giri With Mike & Demetra
Feb 24, 2015 © Feb2d, 2015 & Feb2d4 2015 Li]

Paulina daneing Fenia with sunglasses Rena at Kassas
Fob 24, 2015 0 Feb 24,2015 ®  Feb24,2015 o

Figure 65: CB Gallery photo album

Abbott & Costello admin |~
February 24, 2015

Best Abbott and Costello sceens

© Haw Video Q, | Search Videos...

# Date

1 '+ 7Tinto286 Fab 24, 2015 (-2
2 » TwoTensfora Five @ Feb 24, 2015 -2
3 » Who'sOnFirst® Fab 24, 2015 o-

Figure 66: CB Gallery Video album
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a

Search Albums..

iy e g A e

Mary Chapin...  Willie Nelson Kathy Mattea Harry Belaforte  Trisha Yearw..,

OMusic 0 0Music o 0Music O OMusic & 0Music
r\_ Z r\_ & [—\_ Z I_\_ T
The Monkeys  Beaties DonWiliams  Garth Brooks

0 Music: o 0 Music @ 0 Music @ 0 Music L]

O New Music

Figure 67: CB Gallery Music albums

CB Connect Plugin

L]

CB Connect 6.0 supports eleven (11) social networks and lets you
authenticate your website users using their social networking
credentials.

The 11 social networks supported are:

Facebook
Twitter
LinkedIn
Windows Live
Google
Instagram
Foursquare
GitHub

. Vkontakte
10. Steam

11. Timblr

CoNOO~®WNE

You can learn more about this Professional add-on from the latest
release announcement;

www.joomlapolis.com/news/18472-eleven-social-networks-
supported-with-cb-connect-600-

CB Login
& | Username
8 | Password

| Remember Me

Log in

f Sign in with Facebook

W Sign in with Twitter

in Sign in with Linkedin

28 Sign in with Windows Live

g+ sign in with Google

| {8 Sign in with Instagram

[? sign in with Foursquare
) Sign in with GitHub
N Sign in with VKontakte

' Sign in with Steam

t Signin with Tumblr

Forgot Login?
Sign up

Figure 68: CB Connect
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CB Privacy Plugin

CB Privacy gives you full control to deploy your privacy strategy on your website for your user
profiles and user lists. It is a paid add-on available to Professional members. To learn more about
the CB Privacy plugin you can read the latest release announcement on Joomlapolis:

www.joomlapolis.com/news/18476-controlling-privacy-with-cb-privacy-40

Gender Male (+) Female| @Public =
+ Public
Birthda a8/
i y 04 % Novemb [ —-—
Private
File ;
No change of file Connections
Connections of Connections
Video No change of vide Connection Types
Friend
Marital status — Co Worker
Family
CB Expertise Community Builde Private
Query field e e
CB Invites

Figure 69: CB Privacy setting for gender field

CB Invites Plugin

CB Invites lets you empower your members to invite their friends to your website. With it you
can also configure a closed by-invitation-only registration process. To learn more about this
Professional add-on you can read the Joomlapolis article:

www.joomlapolis.com/news/18473-members-invite-friends-with-cb-invites-40

Susan K. <susank@jp.com> Movember 10, 2014 8:21

Community Buuldér 2.0 - Join me on this great site |

Personal message from Susan :
- = Hi Mat! It was great meeting you last night. This is
e N . the cool site | menticned. | am a regular member
here, so | can send you this personal invitation to
i join. - Sue

Invite code: 9541e04ba157751e1a1155(d29278d44

» Susan's profile » Click here to register

Figure 70: CB Invites email invitation sample
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